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INTRODUCTION 
 

This document is intended to serve as a “what to do” applications guide for users and integrators 
that have adopted Smar’s System302 as process control solution. Smar’s System302 is compliant 
to the FoundationTM Fieldbus Standards. 
 
After studying the contents of this document, one should know the procedures to setup a non-
redundant or redundant system in communication, to get the system in operation, to maintain the 
system, to set and operate redundancy, and how to use additional applications for system 
supervision, diagnosis and maintenance. 
 
To follow the contents of this manual, the user should be familiar mostly with fieldbus concepts, 
such as how a fieldbus physical installation is organized in separated channels or segments, the 
concept of function blocks processing the control inside field devices (which is the essence of 
fieldbus technology) and so on. It is also necessary to know how to deal with the software Syscon, 
how to configure Foundation function blocks in order to make the control strategy work, etc.  
 
However, do not worry if you are not familiar with all these, because references to other Smar 
publications will be made throughout the development of this manual. So, it is always possible to 
learn while using the software according the needs by consulting the other available manuals. 
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Chapter 1 
 

1.1 

PROCEDURE TO THE FIRST SYSTEM   
STARTUP (NON-REDUNDANT) 
 

1.1  – Software Installation 
 
System302 runs under Windows, and it is necessary having administrator rights for the System302 
installation. After the installation, it is necessary to get the License keys from Smar for the software 
Syscon and OLE Server (PCI OLE Server, DFI OLE Server, etc). 
 
1.1.1  – Installing the Software 
 
Install all the parts of the System302 6.1.10 CD-ROM. Follow the instructions of the installation 
guide. These parts are the Syscon, Logic View, FCView, OLE Server (DFI and DF65 Servers), 
Device Support, FBView, FBTools, and Documentation 
 
SYSCON - SYSTEM CONFIGURATION is a software tool specially developed for configuring the 
FOUNDATION Fieldbus TM devices and network. You can run Syscon in off-line mode to do the 
configuration of your FOUNDATION Fieldbus TM system without any communication. And, of course, 
you can also run Syscon in the on-line mode. 
 
Logic View is the software toll used to configure the DF65 Logic Coprocessor. The configuration is 
done in Ladder logic according IEC-1131-3EE. It is easy to learn and use. 
 
FCView is a software tool used in the system operational stage , it means, after the installation, 
configuration and start up of the  AuditFlow system. Using FCView its possible to monitor and act in 
the main function blocks, manage process, create reports, all things made in a way to warranty the 
system inviolability. 
 
OLE Server for Windows is the server-side software used to carry out connection between client-
side software and PCI cards and/or DFI302 plugged in the local computer. The access to this OLE 
Server may be done locally (local connection – server installed at the same station of the OLE 
client) or through a network (remote connection – server installed in other station). 
 
Device Support is a package with DD (Device Description) and CF (Capability File) files. This set of 
files has information about Smar and 3rd party equipments that assure the interoperability of the 
system.  
 
FBView provides the user with the messages that pass through the Fieldbus buses. FBView can 
capture, analyze and decode the messages through an interface also connected to the bus. 
 
FBTools is the utility software used to perform Firmware Download (to load an executable program 
into the FLASH memory) on any Smar Fieldbus equipment (PCI cards, Field Devices and Fieldbus 
Modules). 
 
All Documententation is provide by System302. The documentation includes manuals of field 
devices, controllers and software, showing information  that help the user in the installation, 
configuration, control and operation of the system. 
 
1.1.2  – License Key 
 
Syscon and OLE Server require license keys to operate. The license can be through softkey, 
hardkey and demo license. In order to get these licenses from Smar proceed as follows: 
 
1.1.3  – Softkey  
 
Step 1 – Getting the License Code 
 
It is necessary to send to Smar a License Code, which is a number that is generated after the 
software installation. 
 
From the Start menu, select Programs/System302/System302 Browser and select OPC License. 
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The Get License dialog box will appear. Click the button Generate FaxBack. 
 

 
 
The Softkey dialog box will appear. Fill in the boxes and click the button Finish. The FaxBack form 
will be promptly generated. 
 

 
 
Step 2 – Transmitting the fax 
 
Fax your FAX-BACK form to Smar using the fax number listed on it. Smar will issue you license 
keys to authorize your installed products and reply it to you.  
 
Step 3 – Entering the License Keys 
 
After you have received your license keys, run OPC License again and type the returned license 
keys numbers just as they are printed in the fax. Click the button Grant my License Key. 
For instance, if you got Syscon's License Key, the following dialog box will show up: 
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Now, Syscon and OLE Server are ready to run. 
 
1.1.4  - HardKey 
 
Connect the HardKey on the computer parallel port. 
 
From the Start menu, select Programs\System302\GetLicense. 
 
The Get License dialog box will appear. Check the item Using HardKey and click the button Hard 
key Diagnostic.  
 

 
 
The Hard key dialog box will appear. Click in the Diagnostic button.  
 

 
 
The following window will open. Click OK. 
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The following window will appear. 
 

 
 
Now, Syscon and OLE Server are ready to run. Click OK to open the HardKey Log file. 
 

 
 
 
 

1.1.5  – Demo License 
 
The Demo License allows the execution of a configuration with up to 8 function blocks (without 
counting transducer, resource and display blocks). 
 
From Start menu, select Programs\System302 and choose Get License. 
 
The Get License dialog box will popup. Check the Using Softkey item and click the Use DEMO 
Keys button. 
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The blank fields will be filled. Click on the Grant License Keys button. 
  

 
 
The following dialog boxes will appear. Now, software is ready to run.  
 

                     
 

1.2  – Interface Setup 
 
1.2.1 – PCI Setup 
 
After plugging the PCI in one ISA slots available, it is necessary to set its I/O port and its 
interruption. The setup needs to be done just once, in the very first time that the PCI card is used in 
the computer. 
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The following steps show hints for setting a working IRQ and I/O-port for the PCI Fieldbus Interface 
card. 
 
Step 1 – Finding an available IRQ 
 
An IRQ (Interrupt Request) is basically a work order sent by a peripheral device to the 
microprocessor in a computer. A processor will interrupt the task it is performing and execute the 
new instruction provided by the IRQ. When these instructions have been completed, the processor 
returns to its prior task. 
 
An IRQ conflict occurs when the same IRQ is assigned  to two devices. Since multiple signals to the 
computer on the same interrupt line might not be understood by the computer, a unique value must 
be specified for each device and its path to the computer. Please note that some peripherals can 
share the same interrupt, but many cannot. 
 
Follow the procedure bellow to check a free compatible IRQ according to the operational system 
(Windows NT, Windows 2000, Windows XP) used in your computer. 
 
Windows NT 
 
1. Click the Start button in the lower left corner of your screen. 
 
2. Select Programs and click Windows NT Diagnostics from the Administrative Tools menu. 
 
3. Click on the Resources tab to check for IRQ usage. 
 

 
 
4. The Resources screen shows IRQ information. Windows NT only displays the IRQs being in use 
as services. It does not show all the IRQs used by the system. The IRQs used by typical systems 
are: 0, 1, 2, 6, 7, 8, 13, and 14. Select an IRQ from 5, 10, 11, 12 and 15 which is not already used. 
 
Please see the IRQ reference chart below. 
 

IRQ Used by 
0 system timer 
1 keyboard 
2 cascade to IRQ 9 
3 COM2/COM4 
4 COM1/COM3 
5 Sound Card/(Free) 
6 Floppy 
7 Printer port LPT1 
8 CMOS clock 
9 Free 
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10 Free 
11 Free 
12 PS-2 mouse/(Free)
13 Math processor 
14 Primary IDE 
15 Secondary IDE 

 
5. If there are no free IRQs on a system, it is necessary to free up an IRQ in order to install a NIC 
(network interface card). This should only be attempted by advanced users or trained professionals. 
These professionals should take proper steps to disable any COM ports not in use or remove any 
unnecessary cards.  
 
Windows 2000 
 
1. Click Start, and select the Control Panel option from the Settings menu. 
 
2. Double-click on the Administrative Tools icon, and then double-click on The Computer 
Management icon.  
 
3. In the Computer Management screen, click System Information → Hardware Resources → 
IRQ. The screen should now resemble the one below. 
 

 
 
4. The Resources screen shows the IRQ information. Windows 2000 only displays the IRQs in use 
as services. It does not show all the IRQs used by the system. The IRQs used by typical systems 
are: 0, 1, 2, 6, 7, 8, 13, and 14. Select an IRQs from 5, 10, 11, 12 e 15 which is not already used. 
 
5. If there are no free IRQs on a system, it is necessary to free up an IRQ in order to install a 
network interface card. This should only be attempted by advanced users or trained professionals. 
These professionals should take proper steps to disable any COM ports not in use or remove any 
unnecessary cards.  
 
 
Windows XP 
 
1. Close all applications. 
 
2. Click Start then click Control Panel → Performance and Maintenance → System. 
 
3. Click in Hardware tab and choose Device Manager.  
 
4. Click in View menu → Resources by Type → Interrupt Request (IRQ). The IRQs will be 
displayed on your screen. 
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5. Windows XP only displays the IRQs in use as services. It does not show all the IRQs used by the 
system. The IRQs used by typical systems are: 0, 1, 2, 6, 7, 8, 13, and 14. Select an IRQ from 5, 10, 
11, 12 and 15 which is not already used. 
 
6. If there are no free IRQs on a system, it is necessary to free up an IRQ in order to install a 
network interface card. This should only be attempted by advanced users or trained professionals. 
These professionals should take proper steps to disable any COM ports not in use or remove any 
unnecessary cards.  
 
Step 2 – Dip Switches Settings 
 

Note: All PCIs installed on the PC bus should be configured with the same I/O PORT and 
INTERRUPT, and each one with a different CARD number, but the PCI PORT and IRQ should not 
conflict with cards or peripherals (other than PCIs) already installed in the PC. 

 
The PCI hardware configuration is done through dip switches located on the rear part of the card. 
 

 
 
PCI dip switches 
 

Note: PCI dip switches have external access even after the card is installed inside the PC. The 
user can change their positions while the PC is turned on, but never while an application is running 
on the PC and accessing the PCI card. 
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PCI DIP-SWITCHES
W1 W2 W3 CARD W4 W5 PORT W6 NVRAM BATTERY 
0 0 0 0* 0 0 240..26FH 0 ON (data retention) 
0 0 1 1 0 1 280..2AFH* 1 OFF (data loss)* 
0 1 0 2 1 0 300..32FH   
0 1 1 3 1 1 340..36FH   
1 0 0 4      
1 0 1 5      
1 1 0 6      
1 1 1 7 * Default settings   

 
Select a different CARD NUMBER, usually starting from 0, for each PCI card to be installed in the 
PC. Write down each CARD NUMBER and its respective SERIAL NUMBER.  
 

Note: Dip-switch W6 (NVRAM BATTERY) is factory set to OFF, in order to avoid energy loss 
while the card is stored or not in use.  W6 SHOULD BE TURNED ON BEFORE USING THE 
PCI.

 
Step 3 – Setting the IRQ 
 
To set the IRQ (or port) use the PCI setup utility. The PCI I/O Port configured here must be the 
same one set in Step 2. 
 
From the Start menu, select Programs\System302\Interfaces\ItfSetup. The following screen will 
show up: 
 

 
 
Select PCI and click the button Ok. The PCI Setup dialog box will show up. 
 

 
 
Choose an I/O Port and an IRQ (interruption) that were not being already used and hit OK. 
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WARNING 
Some computers come without IRQ assigned to ISA slots in its BIOS configuration. So, sometimes, 
it will be necessary to access the BIOS configuration and change it. We will notice that the IRQ is 
not working only if we have problems in the section 1.6. 
As there are so many BIOS configuration types, we will not cover all possibilities here, however 
here follows one example: Once upon a time, a certain computer wouldn’t communicate even 
though the PCI was using an interruption that was not being used by any other component of the 
computer. Then, it was necessary to access its BIOS configuration, and, in the part where the IRQs 
are assigned to slots PCI / ISA, we saw that the interruption we chose was assigned to “PCI/ISA 
Pnp” (Slots type PCI or ISA and plug and play). Then, we changed it to “Legacy ISA” and the 
communication got established. 

 
1.2.2 – DFI302 Setup 
 
For further information about the DFI302 setup, see DFI302 manual, chapter 2. 
 

1.3 – Firmware download 
 

1.3.1  – PCI Firmware download 
 
The next thing to do is to download the PCI firmware to the PCIs. For this, it is necessary to run the 
FBTools software. 
 
Step 1 – Opening the FBTools 
 
From the Start menu, select Programs\System302\System302 Application, and double click in 
the item FBTools Wizard. 
 
You can also activate it from the Start menu, selecting Programs\System302\Interfaces\FBTools 
Wizard. 
 
The following screen will pop up: 
 

 
 

Step 2 – Selecting the PCI 
 
Make sure that it is selected PCI on the Device scroll box (see picture below) and hit the button 
Finish. 
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This next screen will pop up: 
 

 
 
The first field on the window, which is designated “Card”, will show all the PCIs that are physically 
installed in the computer and that were recognized by the FBTools application.  
 

WARNING 
If you did not get any card found at the field “Card”, it means that you have set a loaded 
I/O port in the previous section (1.2.1). In this case, it is necessary to make a check for 
any overlapping port configuration (as described in section 1.3.1, step 3) and then, go 
back to the previous section (1.2.1, step 3) and correct the I/O port option.  

 
The above example window is showing “Card 0 – Revision 1.1”. If you open up the options of this 
field, it will show also Card 1, 2, 3 and so on, accordingly to the number of installed PCIs. 
 

WARNING 
The PCI card number is set through positioning dip switches that are located on the rear 
side of the PCI card. If you have problems in this step, please go back to section 1.2.1, 
step 2, and correct the dip switches positions related to card numbers. Each PCI must 
have a different card number. 

 
The second field named “Firmware”, shows where the firmware file is. If you are using PCI version 
1.1, the firmware file will be “Pci11ff.abs”, for PCI version 1.2 the firmware file will be “Pci12ff.abs”. 
The default firmware location is showed in the PCI Download window. So, it is not necessary to 
choose anything for that, except if you want to upgrade your PCI firmware. In this case, it is 
necessary to copy the new firmware file you got from Smar (file with extension “.abs”) to a location 



SYSTEM302 - APPLICATIONS BULLETIN 
 

1.12 

of your choice and then, at the firmware download window above, click the browse button  and 
select that file. 
 
Step 3 – Checking for any overlapping port configurations  
 
In the PCI installation, case the user choose an I/O port already in use, he will have problems to 
select the PCI.   
 
Follow the procedure bellow to check a free compatible I/O port according to the operational system 
(Windows NT, Windows 2000, Windows XP) used in your computer. 
 

Note: Proceed with this step only if you had problems in the steps 1 and 2 of this section. 
Otherwise, go straight to Step 4. 

 
Windows NT 
 
1. Click Start, and select the Administrative Tools option from the Program menu. 
 
2. Double-click on the Administrative Tools icon, and then double-click on the Computer Manager 
icon.  
3. In the Computer Management screen, click System Information → Hardware Resources → IO.  
 
4. Then, if you find that the I/O port you chose is not free, go back to section 1.2.1 and change I/O 
port option. 
 

 
 
Windows 2000 
 
1. Click Start, and select the Control Panel option from the Settings menu. 
 
2. Double-click on the Administrative Tools icon, and then double-click on the Computer Manager 
icon.  
 
3. In the Computer Management screen, click System Information → Hardware Resources → IO.  
 
4. Then, if you find that the I/O port you chose is not free, go back to section 1.2.1 and change I/O 
port option. 
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Windows XP 
 
1. Click Start then click Control Panel → Performance and Maintenance → System. 
 
2. Click in Hardware tab and choose Device Manager.  
 
3. Click in View menu → Resources by Type → Interrupt Request (IRQ). The IRQs will be 
displayed on your screen. 
 
4. Then, if you find that the I/O port you chose is not free, go back to section 1.2.1 and change I/O 
port option. 
 

 
 

Step 4 – Firmware Download 
 
Choose the card which you want to download the firmware and hit the button Download. See the 
picture below: 
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The following window will appear. Just click OK: 
 

 
 
When the download is successfully finished, the following window will appear: 
 

 
 
1.3.2  – DFI Firmware Download 
 
For further information about the DFI302 firmware download, open the DFI302 Manual and look for 
the chapter 3. 
 

1.4  – DEVICE DESCRIPTIONS 
 
In order to assure interoperability between devices of different vendors, a technology called Device 
Description (DD) is necessary. 
 
A Device Description provides the necessary information to the control system or host understand 
the data sent by the field device. So, the DD can be thought as a “driver” for the device. There is a 
DD for each device type, and it consists of the files whose extensions are “.ffo” and “.sym”. 
 
The Capabilities File is used to define the device capabilities – e.g., dynamic block instantiation 
capability - and the resources available for creating Function Block Applications, Resource Blocks, 
Transducer Blocks, and Function Blocks. The Capabilities File consists of the files whit the 
extension “.cff”, and they are placed together with the DD files. The Files are stored in 
manufacturer’s folder, as will be shown later.  
 
1.4.1  – Getting a Device Descriptions 
 
Device Descriptions are supplied by the device vendors or by Fieldbus Foundation if the supplier 
has already registered their DD there. Fieldbus Foundation makes available a CD-ROM with 
standard Device Descriptions. 
 
The next topic shows how to install a Device Description of another vendor (in this case Yokogawa) 
on System302. 
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1.4.2  – Installing a new DD and Capability file on System302 
 
Each type of FOUNDATION fieldbus device has manufacturer’s parameters that are described in DDs 
and capability files. See the example below that shows how to install these files to devices of others 
manufacturers.  
 

Yokogawa Manufacturer ID = 594543
YewFlow – Device Type = 0002 
EJA – Device Type = 0003 

 
Inside de folder Program Files/Smar/Device Support, create a new folder named with the number 
of the manufacturer ID. For instance, for Yokogawa the folder “594543” must be created. 
 
Inside the manufacturer ID folder “594543”, a new folder with the device type number must be 
created. For this example, we have two device types (YewFlow and EJA). So, two folders named 
with their corresponding numbers should be created: folder ”0002” and folder “0003”. 
 
The next picture shows these new folders. 
 

 
 
Inside each folder (0002 and 0003) copy the files with extensions “.ff0” , “.sym” and “.cff”. The 
manufacturer supplies these files. See the next picture: 
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In the “DeviceSupport.ini” file (located in “Device Support” Folder) you will have to add the 
Manufacturer ID and the manufacturer name. This is done in the section “Manufacturer by ID” as 
follows: “594543 = Yokogawa”. See the next picture: 
 

 
 
A section called “Device by code” for the manufacturer must also be created as follows: “[594543 
Device by code]; Yokogawa”. Include the manufacturer device types in this section, “0002 = 
YewFlow” and “0003 = EJA” for this example. See the next picture: 
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1.4.3  – Importing Device Support Files 
 
SYSCON automatically imports the DD and CF files of a device. Therefore it is not necessary follow 
the steps in section1.4.2. 
 

Note: The user must be logged on as an Administrator or a member of the Administrators group to 
import the DD and CF files. 

 
Go to Project File menu, click Import Device Support: 
 

 
 
The Browse dialog box will open. Select the directory where the DDs and CFs of the device being 
imported are located and click Ok. 
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The Import Device Support dialog box will open showing the list of files that will be imported in the 
Device Support folder of the correspondent manufacturer: 
 
 

 
 
Click Ok and a message box will appear informing the user that the operation was successful. 
 

 
 
Click Ok to conclude. 
 

1.5 – Creating a Syscon Configuration 
 
The first necessary thing to do is to make the configuration using Syscon.  
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Note: Users not familiarized with the software Syscon, consult the section “Step-by-Step 
Configuration” on the “Syscon 6.0 – Users’ Manual”. 

 
The fieldbus configuration in Syscon is organized as per the ISA S88 model. 
  
The project is initially divided in two major parts: 

• The Logical Plant or “Area1” 

• The Physical Plant or “Fieldbus Networks”. 
 

 
 
The Area1 is where all the logic part will be kept, as the connection between function blocks, for 
instance. 
 
On the other side, the Fieldbus Networks is where the physical installation is represented, i.e., it is 
where all the fieldbus segments or networks are configured, with all bridges (PCI/DFI302) and field 
devices distributed in the segments the same way they are installed in the field. 
 
Naturally, these two parts are connected. The link between them is the function blocks and that is 
why they are present in both parts. 
 
Syscon was designed so it is possible to make a configuration starting from different points and 
going through different ways. 
 
It is possible, for example, to make first the Physical part, creating segments, devices and function 
blocks in them and after attaching these blocks to the Logical part. 
 
Or one can first create the Logical Plant making all the control strategy and after this, create the 
physical plant and attach the function blocks (previously created in the logical part) to them. 
 
Anyway, after all this is done, we will have a complete configuration, as in the next example: 
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1.6  – Initializing Communication 
 
This section is a step by step guide for communicating FOUNDATION fieldbus devices using Smar 
configuration tools, for the first time. 
 
It will be used as example a Simple PID configuration using the Smar DF51 CPU. After a successful 
firmware download in FBTools and with the system configuration ready, it is time to initialize on line 
communication. 
 
Step 1 – Communication Settings 
 
Open the Syscon configuration file, click over the Fieldbus Networks icon, go to the 
Communication menu and click Settings. Or right-click Fieldbus Networks icon to activate the 
popup menu and select Communication Settings, as in the following figure: 
 

 
 
The Communication Settings dialog box will appear.  Make sure the server settings on this dialog 
are the same as set on the section 1.2, for the PCI or for the DFI302. 
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Step 2 – Initializing Communication 
 

To initialize the communication, click the Operation Mode button, , on the General Operation 
toolbar under the Menu bar. 
 
The video clip below should appear for a couple of seconds. During this time, Syscon will identify 
and attach any bridges installed in the computers to the configuration. 
 

 
 
Step 3 – Assigning the bridges device identification (Device ID). 
 
Note that at this point, if all the procedures were completed successfully, a red X will be prompt at 
the top-left part of each device and bridge icon. It means that no device ID was assigned to these 
yet. 
 
Go to the Fieldbus window, right-click over the bridge icon to activate the popup menu and select 
Attributes, as seen in the next picture.  
 

 
 

The following dialog will show up: 
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Click the down arrow on the Device ID box and select the proper ID from the list. See next figure: 
 

 
 

Note: If the bridge is not in the Device ID list, be sure that the computer and the bridge are 
connected in the same sub-net. Example: Case the equipments (computers and DFIs) are 
connected in a network with IP address 192.168.101.0, they must have IPs in the format 
192.168.101.X ( X identifies the number of the equipment in the network). If the equipments are in 
the same sub-net and the problem persists, verify if there are equipments with the same IP 
number. Example: Two DFIs with the IP address 192.168.101.100.  

 
Hit the button Ok. Now, the X should disappear from the bridge only. 
 
The same procedure must be done for all bridges in the configuration. 
 
Step 4 – Assigning the Device ID to the field devices. 
 
Assign the device ID to each field device, the same way that it was done to the bridge (Step 2). 
Right-click over each device, select Attributes and choose the proper Device ID. 
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Note: It is necessary to associate the device ID to the fieldbus elements only for this first time. 
Then, it will be saved to the configuration file with the Save command, so if in the future one opens 
the Syscon file and starts the communication (initiate communication commands), it won’t be 
necessary to do the device ID association again because it is already there. Only if one device is 
changed is that we have to go at one of those points and change also the device ID, which is 
unique for each fieldbus instrument. 

 
Finally, save your configuration, in order to get the IDs saved. 
 
Step 5 – Device Exchange 
 

Note: This step will have to be executed in configurations with previous versions to the Syscon 6.0 
or to change the device revision. 

 
When a defective device must be replaced by a new device that has a newer or different Device 
Revision, it is possible to exchange these devices easily without modifying the existing 
configuration. Another scenario occurs when the user wants to change the Device Revision for a 
device. 
 
To exchange a device, select its icon, go to the Edit menu and click Exchange. Or right-click the 
device icon and click the item Exchange. 
 

 
 
The Exchange dialog box will open. 
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The user can change the Manufacturer, the Device Type and the Device Revision. The following 
example, we change the device revision. 
 

 
 
The Deviations dialog box shows detailed information of the device, the blocks and parameters, 
indicating to the user the functionalities that can be lost when exchanging the device. 
 

 
 
Click OK to perform de exchange. 
 
You can find more information in Syscon 6.0 manual, section 3.6.7. 
 
Step 6 – Checking the Communication 
 
For every channel (or segment), open the Fieldbus window, right-click over the Fieldbus icon and 
select Live List from the popup menu, as the figure below: 
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Another window will be displayed with all devices connected to the segment, as in the example: 
 

 
 

1.7 – Tags Assignment 
 
In the previous section, one address was automatically assigned to each fieldbus device. Now, it is 
necessary to assign the tags to each one of these devices and interfaces. 
 
Right-click over each bridge and device to activate their popup menu and select Assign Tag, as in 
the next example: 
 

 
 
The tag written in the configuration will be sent to the devices, while you are seeing the following 
clip. 
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Notes: 
1) In order to check if the tag assignment was successful, open the live list of the channel (or 
segment) and see if the tag from the device is the one you sent. 
2) The tag assignment procedure needs to be done just once. It will only be necessary again in 
case a tag is changed or if a device is changed or has its memory erased 

 
1.7  – Erasing the Error Log Registry 

 
It is important to clear the Error Log Registry before downloading the configuration, because any 
eventual error that might occur during the download process will be easily detected as the Error Log 
window pops up automatically at the occurrence of its first error. 

In Syscon, hit the button . It will open the Error Log window (this step will not be necessary in 
case this button is not enabled). 
 
Right-click inside this window and select the option Clear Log, as in the following example: 
 

 
 

1.8  – Downloading the Configuration 
 
There are four ways to do the configuration download to the field devices: plant configuration 
download, channel download, device download and download incremental. See these forms in the 
topics below:  
 
1.8.1  – Plant Configuration Download  
 
In the Project window, click the icon Fieldbus Networks, go to the Communication menu and click in 
the item Download. Or right-click the icon Fieldbus Networks and select the item Download. 
 

 
The Download dialog box will open. To download the entire configuration to the plant, do not select 
the option Incremental download and click in the Start button. 
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To execute the incremental download, check the option Incremental Download before start the 
download. 
 
1.8.2  – Fieldbus Download 
 
To execute the download for each fieldbus segment, click the Fieldbus window, go to the 
Communication menu and click the item Download. Or right-click over the Fieldbus icon to activate 
the popup menu and select Download, as in the next example: 
 

 
 
The Download dialog box will open. Click Start to download fieldbus information. While the 
configuration is being downloaded to your plant, the following dialog will be prompted: 
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To execute the incremental download, check the option Incremental Download before start the 
download. 
  
1.8.3  – Device Download  
 
In case a device failed or after replacing a device, the user can run a partial download for this 
device, provided that it doesn’t change the configuration.  If you have already done the download of 
the entire configuration and the device configuration changes, it is recommended to do the device 
download too. 
 
In the Fieldbus window, click the device icon, go to the Communication menu and click the item 
Download. Or right-click the device icon to activate its popup menu and select the item Download. 
 

 
 
The dialog box Download will open. Click Start to download the device information. 
 

 
 

Note: In case a device failed or after replacing a device, it is necessary execute the Assign Tag in 
the equipment before executing the partial download.  

 
To execute the incremental download, select the option Incremental Download before start the 
download. 
 
1.8.4  - Incremental Download  
 
Syscon 6.0 can compare the project configuration with the plant configuration and then execute the 
download only for the discrepant information, without sending unnecessary information to the 
device. 
 
Step 1 – Enabling the Incremental Download  
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To enable this option, open the file SmarOleServer.ini, located in the folder C:\Program 
Files\Smar\OleServers. 
 
Set the parameter INC_DOWNLOAD_SUPPORT=ON. See picture below. 
 

 
 
Save the file and restart the Smar Ole Server. 
 
Step 2 – Download  
 
Back to Syscon configuration, in the Download dialog box, select the option Incremental download 
to compare the project configuration with the plant configuration. 
 

 
 
The message box in the figure below will appear if SYSCON finds any difference in the 
configuration. 
 

 
 
Click Yes to open the Incremental Download window and check the differences. 
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Click Ok to start the configuration download. 
 
You can find more information in Syscon 6.0 manual, section 6.7. 
 

1.9  – Exporting Tags 
 
It is necessary to execute one further command in order to enable the on-line communication with 
the parameters of the function blocks. This command is called Export Tags. It basically generates a 
file (Taginfo.ini) containing all tags (devices and function blocks) present in the configuration. This 
file is used by the OPC (OLE for Process Control), for supervision purposes.  
 

Note: The Export Tags command has to be executed just once, unless a tag change in the 
configuration is made. In this last case, this command should be executed again to update the file. 

 
Step 1 – Preferences 
 
Before execute the Export Tags, the user can select the mode for operation and the path for the 
Taginfo.ini file. 
 
Go to Project File menu and click Preferences. The following window will appear. Select the 
Export Tag tab. 
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You can choose between two modes: 
Manual: The user has to execute the Export Tag command to update the Taginfo.ini file. 
 
Automatic: The Export Tag will be executed every time a relevant on-line change occurs. In this 
case, a message will appear to confirm the export tags. 
 
Step 2– Exporting Tags 
 
Go to the main window, right-click over the project icon and select Export Tags, as in the figure: 
 

 
 
Then, a Browse for Folder dialog box will show up.  
 

 
 
If the user executed the step 1, the dialog box will show the correct folder to save the Taginfo.ini file, 
otherwise, choose the folder C:\Program Files\Smar\OleServers and click OK. 
 

 
 
Click OK to finish. 
 

Note: Every time you change any tag in the configuration, it is necessary to repeat the Export tag 
procedure, otherwise, the supervision of the new tag will not be allowed. 

 
To update the Taginfo.ini file previously saved, you can use the command Update OPC Database. 
Selects the icon of the project, goes to the Export menu and click Update OPC Database. Or open 
the popup menu right-clicking the Project icon. Click in the item Update OPC Database. 
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Step 3– Checking the on-line supervision 
 
Now, it is already possible to monitor the parameters using the on-line characterization tools. For 
that, right-click over a chosen function block and select On Line Characterization, as in the figure 
below: 
 

 
 

WARNING 
In  Syscon 6.0, the function block parameters can be changed in the On-Line Characterization 
mode. Any of these changes will be saved to the configuration file.  
To previous version of Syscon, the function block parameters can be changed in the On-Line 
characterization mode. However, any of these changes will not be saved to the configuration file. 
They just change the parameter value in the function block in the memory of the field device. So, 
in order to get it saved into file, it is necessary to access also the Off Line Characterization, 
make the same changes and then save the configuration. 

 

1.10  – Recycle Bin 
 
The deleted items are sent to the Recycle Bin. They can be recovered any time, even if the 
configuration is closed and opened again. 
 
To open it, right-click in the Recycle Bin icon located in the Project window and choose the option 
Expand. 
 

 

To display the detailed information about the items, click in the Show/Hide Details button, , 
located in the General Operation Toolbar. 
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To restore blocks, bridges and devices to the configuration, right-click the item in Recycle Bin and 
choose the option Restore.   

 
 

Note: It will not be possible to restore a block or device if the area (Fieldbus, Control Modulo or 
Device) where the item was attached is removed.  

 
You can also delete and see the attributes of the item from Recycle Bin. 
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Chapter 2 
 

2.1 

PROCEDURE TO INITIALIZE A 
REDUNDANT SYSTEM 
 
In order to have a true redundant system, not just all the equipments must be redundant but also the 
entire system topology must be thought as redundant. The more elements with redundancy ability 
the system have, better reliability and availability can be achieved. A typical and simple redundant 
topology based on DFI302 can be seen in picture below. 
 

 
 
What happens when we are dealing with this level of redundancy is that there are two computers, 
each one connected to one or more bridges and each bridge connected to the same segments (See 
figure above). Then, if there is any problem with the active station (LAS) or computer, the backup 
station will take over the communication schedule (will become the LAS) and, as soon as the active 
station is up again, it retakes the charges of LAS. 
 
System302 is provided of two kinds of redundancy: 
  
• Hot Standby 
 

Hot Standby is the redundancy strategy where the Standby module is powered and synchronized 
with the Active module, standing ready to assume if necessary”. 

 
This mode offers redundancy for all the DFI302 functionalities and databases: 
- Gateway: 1 Ethernet port ↔ 4 H1 ports; 
- Link Active Scheduler (LAS); 
- Controller (running Function blocks); 
- Modbus Gateway. 
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Link Active Scheduler is the entity in the network responsible for organizing the communication. 
It basically dictates when each device is allowed to publish/subscribe data to/from the network. 

 
With the Hot Standby mode full redundancy is achieved, heavily improving the plant availability and 
safety. This mode suits specially the cases where the DFI302 has function blocks in its 
configuration. 
 

 
Note: 

- The 4TH FF H1 channel is used as the synchronization path between the modules. Thus, this 
channel will not be used as a usual FF H1 channel and should not have devices connected. 

- DFI302 in Hot Standby mode uses the flat address “0x05” when it publishes. Because third-party 
devices do not support the flat address, they are not able to establish links with the DFI302 in 
Hot Standby redundancy. 

- Hot Standby redundancy is available only for System302 Version 6.1.7 and above. 

 
• LAS 
 
This is a legacy mode of redundancy suitable only for the case where DFI302 does not have 
function blocks in its configuration. That is, in such case the function blocks are on the field devices. 
This is a completely distributed control philosophy where DFI302 perform two main functions: 
- Gateway: 1 Ethernet port ↔ 4 H1 ports; 
- Link Active Scheduler. 
 
For this scenario, with the LAS redundancy the control, operation, and supervision redundancies are 
also guaranteed. 
 
The following procedures inform how to set up and running redundant system. It starts assuming 
that the Software is already installed in the computers and the bridges initial settings were already 
made. If you need some information on how to do that, please refer to chapter 1 of this manual. 
 

2.1 - System Pre-requirements 
 
The requirements listed here apply to both redundancy modes. 
 

2.1.1  Firmware Download 
 
Follow the steps described on section 1.3 and be careful to select the redundant firmware for the 
bridge. 
 
The firmware's names for redundant systems have the termination "r". It indicates a firmware 
suitable for redundant applications. For example: 
 

Bridge Version Firmware 
PCI 1.2 3.7.2 PCI12FFV3.7.2r.abs 
DF51 3.9.1 DF51V3.9.1r.abs 

 
With the redundant firmware, the module initializes by default in Hot Standby mode, in a safety state 
called “Sync_Idle”. The user as will be seen forth can change the redundancy mode later, if 
necessary. 
 

2.1.2  Configuring the Network Redundancy 
 
For any of the redundancy modes it is necessary first of all to configure the network redundancy. 
The next section explains how to do it.  
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2.1.3  Creating the Syscon Configuration 
 
The configuration that has to be created as it is usually done for a non-redundant system (In case of 
doubts, please refer to the section 1.5 of this document). The unique difference (now that 
redundancy is involved) is that it is necessary to add a transducer function block to each bridge in 
the configuration. This transducer will be set then to define how the bridge will work. 
 
One of the bridges will be the Active LAS (Master Station) and the other will be the Backup LAS 
(Backup Station). So, whenever an active or backup station is mentioned, it is related to the bridge 
settings, which configuration will be shown in the next items of this document. 
 
In the SYSCON configuration, the tag for the transducer block can be any, preferentially a 
meaningful tag concerned to the DFI302 tag or to the plant. Be careful to not use tags already in use 
in the same plant. Further information on SYSCON operation, can be found in its own manual. 
 
For Syscon Version older than V.6.1.7, The transducer tag format has to have necessarily the 
following format: 
 

PCI-TRD-“PCI serial number” or 

DFI-TRD-“DFI serial number”  

 
Example (for the bridge with serial number 488):  
 

PCI-TRD-488 or 

DFI-TRD-488  

 

2.2 - Configuring the Network Redundancy 
 
In order all the OPC-Client tools be able to deal with network redundancy it is necessary configure 
the workstation and the DFI OLE Server. 

2.2.1  Configuring the Workstation 
 
It is possible to have one or two workstation (redundancy of workstation). Here follows the steps for 
the configuration. 
 
Step 1 – HMI 
 
Each workstation must have an HMI installed. 
 
Step 2 – Network Interface Card 
 
Each workstation must have installed two NICs (Network Interface Card). 
 
Step 3 – Configuring the NIC 
 
Each NIC must be configured in a different subnet range (e.g. NIC1, IP=192.168.164.50 / Subnet 
Mask 255.255.255.0 and NIC2, IP=192.168.163.50 / Subnet Mask 255.255.255.0). 
 
Step 4 – Gateway 
 
Configure also the default gateway according to your specific needs. 
 
Step 5 – Hubs/Switches 
 
Install two HUBs or switches. Each NIC must be connected to one of them in such a way that two 
LAN are assembled isolated from each other. 
 
That way, each one of the DF51 modules can be connected to one of the HUBs obeying the subnet 
ranges predefined (e.g. First DF51, IP=192.168.164.51 / Subnet Mask 255.255.255.0 and Second 
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DF51, IP=192.168.163.51 / Subnet Mask 255.255.255.0). 
 
Step 6 – Testing the Network 
 
To test the network configuration, use the ping command in the DOS prompt. Click in the Start 
button in the Windows toolbar. Choose the Run option. Type the IP of each DF51 module in the 
Run window to confirm the communication. 
 

 
 

2.2.2  Configuring the DFI OLE Server 
 
There are two ways to configure the OLE Server for network redundancy: Here follows the steps for 
the configuration in each case. 
 
The HMI Client chooses the DFI OLE Server (local and remote).  
 
In this case, the local Server has a specific NIC adapter and the Client chooses what server will be 
used, see figure below. 
 

 
 
Configure in the file SmarOleServer.ini, the NIC adapter that will be used on each workstation ports 
(e.g. First workstation, NIC=192.168.164.50 and Second workstation, NIC=192.168.163.50). Do not 
forget to remove the ‘;’ at the beginning of the line. See figure below. 
 



Procedure to Initialize a Redundant System 
 

2.5 

 
 
Doing so, each DFI OLE Server will choose the specified NIC adapter. 
 
When configuring the HMI, configure each TAG to be monitored using two possible ways: First one, 
using Local DFI OLE Server, second option, using Remote DFI OLE Server (some HMI does not 
permit this kind of configuration and you will need to use an external software). 
 
To validate the Remote connection between Client and Server, make sure to configure DCOM and 
NT Security. The steps are described in the Appendix A in the DFI302 manual. 
 
The DFI OLE Server is connected to both subnets where are located the redundant modules. 
 
In this case, the client uses only one server that will choose which NIC adapter is to be used, see 
figure below. 
 

 
 
Configure in the file SmarOleServer.ini the NIC adapters as intended. Example: NIC = 
192.168.164.50, NIC2 = 192.168.163.50 
 

 
 
Doing so, the DFI OLE Server will have information through both the NIC adapters.  
 
The last updated good data will be chosen by the DFI OLE Server to be forwarded to the client. 
When the DFI302 is in Hot Standby mode, the DFI OLE Server will preferably choose the data that 
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came from the Active module, to be forwarded to the client. 

2.3 - Configuring the Hot-Standby Redundancy 

2.3.1  First Time Configuration Procedure 
 
This is the procedure to configure the system with Hot Standby Redundancy for the first time, at the 
plant start-up. 
 
Step 1 – Factory Init 
 
With the H1 connector disconnected, execute a Factory Init in both modules in order to grant the 
default state. 
 
Step 2 – Activating the Bridge 
 
Connect both modules together, through the FF H1 channels (1 to 4). 
 
Step 3 – Initializing Communication with the Active Bridge 
 
Open the desired configuration in the SYSCON and put it in On-line mode. Attribute the Device ID 
to the bridge. Proceed according section 1.6, steps 1 to 3 for the active station. 
 
Step 4 – Adjusting the transducer tag 
 
Even in the bridge icon, right-click the field FB VFD and then click Block List.  
 

 
 
A new window will be opened showing all the blocks pre-instantiated in the module. Then, right-click 
the transducer  performing an Assign Tag with the tag that is predicted in the configuration.  
 

 
 
Close the Block List window. 
 
Step 5 - Reading Profiles 
 
Right-click the transducer icon in the bridge and choose On Line Characterization.  
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Set the parameter FUNCTION_IDS as Sync_Main.  
 

 
 
Through the synchronism path, the other module automatically will be initialized as Backup. After 
that, both the parameters RED_SYNC_STATUS (L and R) will indicate Maintenance, which means 
that neither of the modules was configured yet; 
 



System302 Applications Bulletin 
 

2.8 

 
 
Click in the Close button to close the window. 
 

Note:  When closing the window On Line Characterization is recommended not to 
save the modified parameters. 

 
Step 6 – Initializing communication with field devices 
 
If necessary, perform Assign Tag for all the field devices. Wait until the Live Lists of all the channels 
are complete. Proceed as section 1.6 (step 4) and 1.7. 
 
Step 7 – Configuration Download 
 
Configure the system through the Active module executing all necessary downloads exactly the 
same way for a non-redundant DFI302 system (section 1.9 and 1.10). 
 
As soon as the downloads are successfully completed, the transducer will show the following 
phases: 
 
1. The Active will transfer the whole configuration to the other module 

(RED_SYNC_STATUS_L as Updating Remote and RED_SYNC_STATUS_R as 
Maintenance); 

2. After the configuration is successfully transferred, the modules can take some time to 
synchronize (parameters RED_SYNC_STATUS (L and R) as Synchronizing). This is 
the time necessary to the modules to check the configuration with each other; 

3. Finally, the modules will synchronize (parameters RED_SYNC_STATUS (L and R) 
as Synchronized and RED_STATE_R as Standby). Once the system is on these 
conditions, the Active will be constantly updating the Standby. 

 

2.3.2  Changing the Configuration 
 
Just follow the steps 6 and 7 of the section 2.3.1. 
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2.3.3  Adding redundancy to a system in operation 
If a non redundant system is intended to be redundant in the future, at the plant startup, the 
following conditions must be obeyed: 
 
Step 1 – Synchronism Channel 
 
The 4th H1 port should be reserved as synchronization path. That is, this port should not have 
devices connected to it. 
 
Step 2 – H1 Channel Cabling 
 
Predict H1 channels cabling considering that a Backup module will be added in the future (the H1 
channels of the Main module should be connected in parallel with the respective H1 channels of the 
Backup module). 
 
Step 3 – Network Architecture 
 
Predict that the LAN architecture can be expanded, in order to attend what is described in the 
Redundant System Architecture. 
 
Step 4 – Initializing the Single Module 
 
The single module should use a redundant firmware (a version terminated in R). The parameter 
FUNCTION_IDS should be set as Sync_Main. This way the module will work in Stand Alone state 
and will be ready to recognize a new module inserted at any time.  
 
Obeying these conditions, redundancy can be added at a later time without process interruption.  
The procedure to add redundancy to the system is just follow the same steps described in the 
section8.1, “Replacing a module with failure”. 
 

2.4 - Configuring the LAS Redundancy 
Here follows the steps for the configuration and maintenance of this legacy mode. It is 
recommended that the steps are all read and understood before are executed. 

2.4.1 - First Time Configuration Procedure 
 
This is the procedure to configure the system with LAS Redundancy for the first time, at the plant 
start-up. 
 
Active Module 
 
Step 1 – Factory Init  
 
With the H1 connector disconnected, execute a Factory Init in both modules to grant the default 
state. 
 
Step 2 – Activating the System 
 
Connect the H1 connector to the Active module. Keep the Backup module with the H1 connector 
disconnected for a while. 
  
Step 3 – Initializing Communication with Active Bridge 
 
Open the desired configuration in the SYSCON and put it in On-line mode and attribute the Device 
ID to the bridge. Proceed according the section 1.6, steps 1 to 3 for the Active station. 
 
Step 4 – Adjusting the Transducer Tag 
 
Even in the bridge icon, right-click the field FB VFD and then click Block List.  
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A new window will be opened showing all the blocks pre-instantiated in the module. Then, in this 
window, right-click the transducer performing an Assign Tag with the tag that is predicted for the 
Active in the configuration.  
 

 
 
Close the Block List window. In the main menu of SYSCON, go to Export Tags. 
 
Step 5 - Reading Profiles 
 
Right click in the transducer icon and choose the option On Line Characterization, Change the 
parameter FUNCTION_IDS to Active and press the End Edit button. See example below: 
 

 
 
Even in the transducer block, set the parameter SYSTEM OPERATION as “Redundant” and close 
the window 
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Step 6 – Initializing the Communication with field devices 
 
If necessary, perform Assign Tag for all the field devices. Wait until the Live Lists of all the channels 
are complete. Proceed according section 1.6 (step 4) and 1.7. 
 
Step 7 – Configuration Download 
 
So, configure the system through the Active module executing all necessary downloads exactly the 
same way for a non-redundant DFI302 system (section 1.9 and 1.10). 
 
 Backup Module 
 
Before connecting the H1 connector to the Backup module, follow the steps below. 
 
Step 1 – Initializing Communication with the Backup Bridge 
 
In the SYSCON configuration, put in On-line mode and attribute the Device ID to the backup bridge. 
Proceed according the section 1.6, steps 1 to 3 for the Backup station. 
 
Step 2 – Adjusting the Transducer Tag 
 
In the configuration change temporarily the tag of the transducer (Backup must have it different from 
that one used for Active). In the main menu, go to Export Tags. 
 
Even in the bridge icon, right-click the field FB VFD and then click Block List. A new window will be 
opened showing all the blocks pre-instantiated in the module. Then, in this window, right-click the 
transducer performing an Assign Tag with the tag that is predicted for the Backup in the 
configuration. Close the Block List window. 
 
Step 3 – Reading Profiles 
 
Right-click the transducer icon in the bridge and choose On Line Characterization. Set the 
parameter FUNCTION_IDS as Passive. 
 
Step 4 – Connecting the Backup Bridge 
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And then, connect the H1 connector to the new module, and after that set the parameter 
FUNCTION_IDS as Backup. 
 

 
 
Step 5 – Setting System Redundancy 
 
Even in the transducer block, set the parameter SYSTEM OPERATION as “Redundant” and close 
the window. 
 

 
 
Step 6 – Download Schedule 
 
For each one of the channels used in the configuration right-click the Fieldbus icon and choose the 
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option Download Schedule. 

 
 

 
Note: The parameter SCHEDULE_UPDATE in the transducer should not be used anymore. 
Instead of it use the option Download Schedule as described in the step above. 

 
Now, the backup will build your schedule automatically. The redundant system is ready. 
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Chapter 3 
 

3.1 

PROCEDURE TO SET A DEVICE TO BE 
LINK MASTER 
 
The field devices have also the capability to become the LAS (Link Active Scheduler) of a fieldbus 
network if the bridge (original LAS) fails or is disconnected from the networks. It is a very interesting 
feature because it enables the system to be totally independent from the bridge and, consequently, 
totally independent from the computer stations, where the bridges are connected. 
 

Link Active Scheduler is the entity in the network responsible for organizing the communication, 
i.e., it basically dictates when each device is allowed to publish/subscribe data to/from the network. 

 
However, this functionality needs to be set, i.e., by default, the devices are not set to work as link 
masters. Other important point is that a device can only be set as link master in a system that is 
already properly functioning, i.e., up and running. 
 
The following steps show how to set a device in an operating system to be link master: 
 
Step 1 – Initializing Syscon Communication 
 
Unless the user already has the Syscon communicating with the device, open the Syscon 
configuration and proceed according the section 1.6 (Initializing Communication), steps 2, 4 and 6 
only. (Note that the step 3 do not has to be repeated because it has to be executed just in the first 
time that a device is used in the network). 
 
Step 2 – Selecting the right device 
 
Select the device configured with less function blocks and less external links. This device is the one 
that originally performs fewer functions in the network, and so, it is the best choice for a new task 
assignment - the link master function. 
 

External Link is a link between function blocks of different devices. 

 
Step 3 – Change the device BOF class 
 
Inside the Fieldbus window, right-click over the device icon to activate the popup menu and select 
Attributes, as in the figure: 
 

 
 
The following windows will be prompted: 
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Change the BOF class to Link Master, as in the figure: 
 

 
 
Close the Attributes window. 
 
Right-click over the device icon again and select Change BOF Class. 
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Step 4 – Turn the device off and back on 
 
Wait 30 seconds until the device save the changes and turn off the device by disconnecting its 
wires, then wait ten seconds and turn the device back on.  
 
Step 5 – Download 
 
Proceed with an update on this device and wait until it finished. 
 
Right-click over the device icon to activate the popup menu and select Update. 
 

 
 
Then, proceed with a download on this device. 
 
Right-click over the device icon to activate the popup menu and select Download. 
 



System302 Applications Bulletin 
 

3.4 

 
 



Chapter 4 
 

4.1 

PROCEDURE TO SET THE BRIDGE TO 
ACTIVE, BACKUP OR PASSIVE 
 
Step 1 – Initializing Communication 
 
Proceed according section 1.6, steps 2 and 3 for the active or master station. 
 
Step 2 – Changing the Parameter 
 
Select On Line Characterization for the transducer block and change the parameter 
FUNCTION_IDS to Passive, Backup, Active Not Link Master or Active, and click End Edit. See 
the next picture as an example: 
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5.1 

PROCEDURE TO BRING REDUNDANT 
STATIONS BACK 
 
There is also a procedure to bring the stations back on after they have been turned off for some 
reason. If you turn them on at the same time, there will be many collisions on the network because 
both bridges (Active and Backup) will try to become the LAS at the same time. It will cause a delay 
for the perfect communication to be established. So, in order to avoid that problem proceed as 
follows. 
 
Step 1 – Turning the First Station On 
 
Turn the first station on. Wait until it is on-line. 
 
Step 2 – Turning the Second Station On 
 
Turn the second station on.  
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6.1 

PROCEDURE TO CONNECT A 
REDUNDANT WORKSTATION WHEN THE 
H1 CABLE BREAKS 
 
If a fail occurs in a segment of H1 line such that it affects only one module, the redundancy will 
cover this fail. But, if the H1 cable is re-connected at once, the noise introduced in the line will cause 
communication problems for some time. In order to avoid that problem, follow the procedure below. 
 
Step 1 – Deactivating the Bridge 
 
Put the module affected by H1 cable fail in Hold using the FBTools. 
 
Step 2 – Re-connecting the cable 
 
Fix up the cable connection. 
 
Step 3 – Activating the Bridge 
 
Perform a Reset in the affected module in order it returns operating.  
 
When using Hot Standby Redundancy, the module will be automatically recognized by the Active 
and both will stay in Synchronizing for some time. As soon the system get the Synchronized status 
and <none> in the parameters Bad Conditions, the redundancy will be fully available and failure 
simulations can be performed. 
 
In LAS Redundancy, the system will be fully available and failure simulations can be performed.  
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7.1 

PROCEDURE TO UPDATE A BRIDGE 
FIRMWARE TO A REDUNDANT SYSTEM 
 
This procedure describes how to update the firmware of both modules without process interruption. 
 

7.1 - Hot Standby Redundancy 
 
Step 1 – Firmware Download – Active Module 
 
Be sure the system is in the Synchronized status and it has <none> in the parameters Bad 
Conditions. So, using FBTools update the firmware of the Active module. At this moment, the other 
module will take over. 
 
Step 2 – Synchronizing the modules 
 
After the firmware update was finished, the modules will start to synchronize with each other, with 
the Active transferring the entire configuration to the other one. Wait for the system get the 
Synchronized status and it has <none> in the parameters Bad Conditions. 
 
Step 3 – Firmware Download – Backup Module 
 
Using FBTools update the firmware of the Backup module. At this moment, the other module will 
take over. 
 
Step 4 – Synchronizing the Modules 
 
After the firmware update was finished, the modules will start to synchronize with each other, with 
the Active transferring the entire configuration to the other one. As soon the system get the 
Synchronized status and has <none> in the parameters Bad Conditions, the redundancy is fully 
available again and failure simulations can be performed. 
 

7.2 - LAS Redundancy 
 
Step 1 – Firmware Download – Active Module 
 
Using FBTools update the firmware of the Active module. At this moment, the other module will take 
over. 
 
Step 2 – Synchronizing the Modules 
 
After the firmware update had finished successfully, follow the steps 4 to 9 of section 8.1.1, 
“Replacing an Active module with failure”. 
 
Wait around one minute in order the Active module become the LAS again (the Active is always the 
preferential in this mode of redundancy). 
 
Step 3 – Firmware Download – Backup Module 
 
Using FBTools update the firmware of the Backup module. 
  
Step 4 – Configuring the Backup Module 
 
After the firmware update had finished successfully, follow the steps 1 to 5 of the section 2.4.1, “First 
time configuration procedure-Backup Module”. 
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8.1 

REPLACING A MODULE WITH FAILURE 
 
If the Active module fails, the Backup module takes over as LAS (Link Active Scheduler). Follow this 
procedure to replace the bridge from the Active Station. 
 

8.1 - Hot Standby Redundancy 
 
Step 1 - Deactivating the bridge 
 
Disconnect the H1 connector from the Active module and insert the new module in the backplane. 
 
Step 2 – Firmware Download 
 
Update the firmware in the new module, if necessary. Follow the steps described in the section 2.1 
to select the firmware file for download. Perform a Factory Init in the new module in order to grant 
the default state. 
 
Step 3 – Reconnecting the Bridge 
 
Reconnect the H1 connector to the new module. 
 
Step 4 – Recognizing the Modules 
 
The new module will be automatically recognized by the Active and both will stay in Synchronizing 
for some time. As soon the system get the Synchronized status and <none> in the parameters Bad 
Conditions, the redundancy will be fully available and failure simulations can be performed. 
 

8.2 - LAS Redundancy 
 
Replacing an Active module with failure 
 
Step 1 - Deactivating the bridge 
 
With the H1 connector disconnected, insert the new module in the backplane. 
 
Step 2 – Firmware Download 
 
Update the firmware in the new module, if necessary. Follow the steps describe in the section 2.1 to 
select the firmware file for download. Perform a Factory Init in the new module in order to grant the 
default state. 
 

 
Note: Before connecting the H1 connector to the new module follow the steps bellow. 

 
Step 3 – Initializing Communication 
 
Proceed according section 1.6, steps 2 and 3, for the active or master station. 
 
Step 4 – Adjusting the Transducer Tag 
 
Even in the bridge icon, right-click the field FB VFD and then click Block List. A new window will be 
opened showing all the blocks pre-instantiated in the module. Then, in this window, right-click the 
transducer performing an Assign Tag, according to the serial number of the Active station Close the 
Block List window. In the main menu go to Export Tags. 
 
Step 5 – Reading the Profiles 
 
Right-click the transducer icon in the bridge and choose On Line Characterization. Set the 
parameter FUNCTION_IDS as Passive.  
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Step 6 - Reconnecting the Bridge 
 
Now, connect the H1 connector to the new module, and after that set the FUNCTION_IDS as Active 
Not Link Master. 
 
Step 7 – Setting System Redundancy 
 
Even in the transducer, On Line Characterization, set the parameter SYSTEM_OPERATION as 
Redundant. 
 
Step 8 – Download Schedule 
 
For each one of the channels used in the configuration right-click the Fieldbus icon and choose the 
option Download Schedule. 
 
Step 9 – Activating the Master Station 
 
Change the parameter FUNCTION_IDS from Active Not Link Master to Active. 
 

Note: Option Active not link master is available only for PCI firmware version 3.3.5.20, DFI 
firmware version 3.0.8.9 and upper. For the PCI, it is also required to replace the DD files (.ffo and 
.sym) to files generated Tuesday, January 18, 2000 3:13 PM for all versions (0101, 0102 and 
0103). 

 
Replacing an Backup module with failure 
 
Step 1 - Deactivating the bridge 
 
With the H1 connector disconnected, insert the new module in the backplane. 
 
Step 2 – Firmware Download 
 
Update the firmware in the new module, if necessary. Perform a Factory Init in the new module in 
order to grant the default state. 
 

 
Note: Before connecting the H1 connector to the new module follow the steps bellow. 

 
Step 3 – Configuring the Backup Module 
 
Follow the steps 1 to 6 of the section 2.4.1,  “First time configuration procedure-Backup Module”. 
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9.1 

PROCEDURE TO REPLACE A FIELD 
DEVICE 
 
Step 1 – Checking the device version 
 
Make sure the new device has the same version as the old one. 
 
To check the version turn the device off and on, the version will show up in the display. If you have a 
different version, please contact Smar, or upgrade the version using FBTools. 
 
Step 2 – Replacing the device physically 
 
Disconnect the old device and connect the new one. 
 
Step 3 – Changing the configured device ID 
 
On Syscon, initialize the communication and change the device ID of the device in the configuration 
to the one of the new device connected to the bus. (In case of doubts, please refer to the section 
1.6, steps 2 through 6). 
 
Step 4 – Assigning the Tag  
 
Assign the configured tag to the field device. (In case of doubts, please refer to the section 1.7). 
 
Step 5 – Download 
 
Proceed with a download on this device. 
 
Right-click over the device icon to activate the popup menu and select Download. 
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Chapter 10 
 

10.1 

PROCEDURE TO REPLACE THE PCI 
CARD  
 
If you need to replace a PCI card for some reason, proceed as follow: 
 
Step 1 – Replacing Physically the PCI 
 
Turn the computer off. 
 
Replace the PCI card in the ISA slot of the computer. 
 
Step 2 – Setting the PCI Dip-Switches 
 
Position the new PCI dip switches the same way they were for the old PCI (if you have doubts here, 
please refer to the section 1.2.1, step 2 of this document). 
 
Step 3 – Setting the PCI IRQ 
 
Turn the computer on. 
 
Run the program Interface Setup to set the IRQ for the PCI card. In this program the I/O is set and 
also the IRQ. The I/O must be the same set in the dip switch configuration. (In case of doubts, 
please refer to the section 1.2.1, step 3 of this document). 
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11.1 

PROCEDURE TO CONFIGURE THE 
SUPERVISION TIME 
 
The Supervision Time is the time required for the Interface card to acquire the entire field device's 
data destined for the supervision workstation. Remember that this data is sent through the 
background time part of the macro cycle part. During the Supervision Time the interface device 
completely refreshes its internal database. So, it only makes sense to be performed in a system that 
is already up and running, together with all HMI (Human Machine Interface) software involved. 
 
The transducer block has four (4) parameters that are used to optimize the supervision in 
System302. 
 
• Parameter 1: SUP_UPDATE_CONFIGURED_ms  
• Parameter 2: SUP_UPDATE_SUGGESTED_ms  
 
These two parameters define the time that the bridge has to poll the supervision data from the 
devices.  
 
• Parameter 3: NO_DATA_CHANGE_TIMEOUT_ms  
 
No data change is a mechanism to optimize the data transference between the bridge and the HMI 
software. With this mechanism the bridge will only send data that has changed. 
 
The HMI has a time-out for the data, which means that if it does not receive a communication point 
after a certain period it will indicate lack of communication. That is where the 
NO_DATA_CHANGE_TIMEOUT_ms comes in. It will define a time-out to the bridge, if a certain 
value does not change over that period it will be sent to the HMI any way, avoiding the HMI time-out 
to expire. 
 

Note: Good values for the parameter NO_DATA_CHANGE_TIMEOUT_ms are between the 
ranges 2500 to 6000, depending on the configuration load. 

 
• Parameter 4: MVC_ENABLE  
 
MVC - Multiple variable containers, is a data container that will have all the supervised points of a 
device. If it is disabled the supervised points are sent through block views. Each block has 4 views, 
which gives a lot of overhead to the communication. 
 
The MVCs come to optimize this communication, send only one big packet per device instead of 4 
small ones per block.  
 
To enable it, just set the MVC_ENABLE parameter to "Enable". 
 

11.1 – Defining the Update Time for Supervision 
 
Update Time is the time that a data shown in the workstation screen takes to be refreshed. During 
the Update Time the HMI software reads the interface device database and updates its own 
database, using this one to refresh the values in the screen. The interface card can be configured to 
send all the values to the HMI or only the ones that have been changed, optimizing in this way the 
update time and reducing the load on the data highway. 
 
Step 1 – Syscon communication Initialization 
 
Open Syscon and initialize the communication, according the section 1.6, steps 2, 4 and 6 of this 
document. 
 
Step 2 – Initial setting of the parameter SUP_UPDATE_CONFIGURED_ms 
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In Syscon, choose On Line Characterization for the transducer block and set 
SUP_UPDATE_CONFIGURED_ms to "5000", and click the button End Edit. See the next picture 
as an example: 
 

 
 
Step 3 – Closing Syscon 
 
Close the Syscon Application. 
 
Step 4 – Running the HMI 
 
Run the HMI software and make sure it is the only OPC client (client of the OLE Server) available. 
 
Leave the HMI software running alone for 10 minutes. 
 
 
Step 5 – New Syscon Communication Initialization 
 
Open Syscon and initialize the communication, according the section 1.6, steps 2, 4 and 6 of this 
document. 
 
Step 6 – Check the value in SUP_UPDATE_SUGGESTED_ms 
 
In Syscon, choose On Line Characterization for the transducer block and read the parameter 
SUP_UPDATE_SUGGESTED_ms. See the next picture as an example: 
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Still in this On Line Characterization window, set the parameter SUP_UPDATE_CONFIGURED_ms 
to the suggested value, plus 500 or more. 
 

 
 
This configuration will define the time the bridge must poll all the supervisory data from the devices. 
The more time you allow to it, more time the system has to maintenance and administration, like 
assigning tags or recovering devices. 
 

11.2 – Setting the No-Data Change Timeout 
 
In Syscon, choose On Line Characterization for the transducer block and set 
NO_DATA_CHANGE_TIMEOUT_ms to a value up to 6000. See the next picture as an example: 
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After you set this parameter, check the HMI supervision.  If you have communication problems, try 
increasing the value of this parameter. 
 

11.3 – Enabling the MVC 
 
In Syscon, choose On Line Characterization for the transducer block and set the parameter 
MVC_ENABLE to Enable. See the next picture as an example: 
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AA.1 

INTEGRATING VARIABLES BETWEEN 
FIELDBUS AND LC700 
 

Introduction 
 
The Smar’s Programmable Controller, the LC700, is a unique programmable controller in the 
market because it has a special module, the fieldbus module or simply FB700.  
 
This module is basically an electronic board that serves as an interface data between the Fieldbus 
networks and the programmable controller’s CPU. This feature is very powerful because it gathers 
all the control strategies along the fieldbus to the Programmed Logic inside the programmable 
controller. 
 
For example, a pressure value can be sent from a fieldbus segment to the programmable controller 
and being used as an interlock condition; Or, in other situation, a switch position can sent from the 
programmable controller to the fieldbus and determine a valve to be sent to a desired position. 
These are only two simple examples of the advantages of it. 
 
In this scenario, this document informs the necessary configurations that are necessary to transfer 
digital and analog variables among Fieldbus networks and the LC700. 
 
Knowledge on how to use the software Syscon and Conf700 is considered pre-requisites to 
understand the contents of this guideline. So, in case of doubts, consult the Syscon and Conf700 
manual for reference. 
 

1 – Overview 
 
What exactly enables the transference of data between fieldbus and the PLC is that the FB700 
module is connected to a fieldbus segment and also to a PLC set, and that the FB700 has related 
function blocks that are configured in both software, Conf700 and in Syscon. The following table 
shows how these function blocks are related. 
 

Conf700 (PLC configuration) Syscon (Fieldbus configuration) 
CODD (Communication Output of Digital Data) MDI (Multiple Digital Input) 
CIDD (Communication Input of Digital Data) MDO (Multiple Digital Output) 
COAD (Communication Output of Analog Data) MAI (Multiple Analog Input) 
CIAD (Communication Input of Analog Data) MAO (Multiple Analog Output) 

 
Note that what is an output function block for the PLC is an input function block for the fieldbus. This 
relative concept is important to be understood to avoid confusions later on. 
 
So, what happens is that the FB700 automatically transfers what is configured in the output blocks 
in the Conf700 to their respective input function blocks in Syscon and vice-versa. 
 
Each one of these function blocks have eight I/O (Inputs or Outputs) points. 
 
Lets check now the next sections, which describes the necessary configuration for the four possible 
types of data transfer. 
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2 – Transferring a Digital value from the PLC to Fieldbus 
 
It is necessary to have at least one Digital input module, such as the M-010, which has eight 120 
VAC inputs, and a Fieldbus card (FB700) with at least one function block, the CODD 
(Communication Output of Digital Data) set in the LC700. 
 
The necessary configuration in the PLC, which is made through the software Conf700, is as shown 
in the next figure where the first input of the module M-010 (in this example) is being passed to the 
first output of the function block CODD. 
 

 
 

Note: The last digit of the default label shown in the figure (CODDG1B8O002.0) means the I/O 
number, which starts from 0 and goes till 7 (eight I/O). So, in the figure we have configured the first 
points of those groups (M-010 and the CODD) configured. 

 
This way, the digital value is available to the fieldbus (now, using the software Syscon), in the first 
output of the fieldbus function block MDI (Multiple Digital Input) of that FB700, which is OUT_D1. 
This output parameter can be linked to any digital input parameter of the other blocks available on 
the bus. If the value is needed only for monitoring purposes, it is not necessary to make links. 
 

3 – Transferring a Digital value from the Fieldbus line to the PLC 
 
In Syscon, it is necessary to configure a link of any digital value to an input of the block MDO, as in 
the following picture. 

 
 
Them, the digital value will be available for the PLC logic in the FB block CIDD (Communication 
input of digital data) present in the FB700. Then, it is possible to use this value, for example, to 
activate an output of a digital output module, such as in the example below: 
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4 – Transferring an analog value from the PLC to the Fieldbus line 
 
We could use, for instance, the analog module M-401 passing the value of one of its inputs to the 
FB700, through the block COAD (Communication Output of Analog Data). 
 
So, it would look like this: 
 

 
 
Note that it is necessary to use a built in function block to connect the M-401 point to the COAD 
point. The function block used is the ITR (Integer to Real converter), which converts an Integer 
value to Real, because the variables of the analog module M-401 are Integer while the variables of 
the COAD are Real. 
 
So, the first input of the M-401 was connected to the first input of the COAD, in this case with default 
label COADG1F8O002.0. This label is not shown in the ladder because more them one point can be 
linked to that same function block output. 
 
That function has also the input EN that is set to true so the function is executed. Also, the other 
output, ENO, is required to be linked to something so the block will operate. In this case we just 
connected it to a not used virtual variable. 
 
Now, this value is already available at the first output of the function block MAI of the FB700 in 
Syscon to be linked to any analog input of other fieldbus function blocks, or just to be monitored (in 
this last case, no links are necessary). 
 

5 – Transferring an analog value from the Fieldbus to the PLC 
 
In Syscon, links can be made connecting analog outputs of any function block to an input of the 
block MAO. See an example in the next figure: 

 
In this situation, the analog value will be available at the first output of the FB block CIAD 
(Communication Input of Analog Data) present in the FB700 to be used in the Conf700. And this 
value can be used to be connected to an analog output module as the M-501 or used in one of the 
many functions available in the Conf700 (ADD, PID, and so on). So, for instance lets link it to an 
output of the M-501 (LC700 analog output module). 
 

 
 
In this example, we used a function RTI (Real to Integer converter) to convert a Real data to an 
Integer data so the value can be passed to the module M-501, which deals with Integer type of 
variables. Note that the label for the point used in the M-501 is also not shown, which can only be 
viewed on the label dialog box of the Conf700. 
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Also the I/Os EN and ENO were linked as shown for the same reasons explained in section 4. 
 
These were simple examples that cover all possibilities of data sharing between Fieldbus and 
LC700, If you need more details on that of if any additional information should be present, please e-
mail your questions or comments to di@smar.com.br.  
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AB.1 

ICS / DF65 APPLICATION BULLETIN 
Introduction 

 
The Computer and the DF65 communicate between each other based on the Master-Slave 
MODBUS RTU protocol. This means that the host Computer always needs to have the initiative of 
the transaction sending a command to the DF65. The DF65 will receive the request and send a 
response after interpretation. 
 
The DF65 has three non-independent serial ports. Only one can be used at a time!  
The CPU Module carries a DB9 connector for RS-232C and regular terminals for the RS-485 
physical connections. Communication with the CPU module can be established via the Serial Port 
RS-232C (EIA-232C) for local connection or RS-485 (EIA-485) for long distance connections in an 
industrial environment. The protocol in both of these channels is the same MODBUS RTU. 
 
These channels can be used for configuration or monitoring. When the RS-232 channel is used, it 
automatically seals the other (RS-485) and maintains communication with the local computer until 
disconnected.  
The RS-232C is oriented for local connection and is only a point-to-point transaction while the RS-
485 provides multi-drop capability and better noise immunity performance for high speed and larger 
distance communication. It is a balanced kind of communication signal more oriented for industrial 
sector. 
 
Throughout the RS-232C or RS-485 using Modbus protocol, we can access: 
 
· All I/O signals from the Modules and Auxiliary variables created (Virtual Variables). 
 
· All linked signals from the I/O blocks in the Fieldbus Module channel (Analog or Digital 
Variables). 
 
 
Most Man Machine Interface packages in the market are able to interact with the DF65 for 
monitoring purposes.  
 
For industrial and long distance connections it is recommended to use an RS-485 network. 
Considering the fact that most of host computers have their serial ports with RS-232C, the user will 
need to find a converter for his application in order to use an RS-485 network. 
 
It is recommended to use an RS-232 to RS-485 interface/converter optically isolated for a better 
system protection.   
 
SMAR ICS2.0PRS-232 to RS-485 interface/converter is a perfect fit for the DF65 once it is optically 
isolated and has been tested on industrial environments. 
 
SMAR DF65 programmable controller has two Half duplex EIA485 (RS-485) communication 
channels. The ICS2.0Pneeds to be set to work without echo, and we will be able to connect up to 31 
DF65's.  
 
The following instructions must be observed to proceed a correct installation. 
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Serial Communication Settings 
 
Device Communication Baud rate and Device Address 
 
The CPU module has a key where user may select default communication parameters (DCP, Switch 
4 ON) or programmed communication parameters (PCP, Switch 4 OFF).  Default parameters are 
address 1 and baud rate 9600 bits/s. 
 
In the PCP position user might select new address and/or baud rate, using LogicView. The new 
adjust of parameters will be accepted only after the key being moved to the PCP position.  In the 
PCP position user also is able to change communication parameters. In this case they will be 
accepted immediately after they have been sent. 
 

Setting the DIP Switches 

 Communication Switch 
In the CPU module, between the communication ports, there is a group of 4 switches. Using a small 
screwdriver make sure that the lowest key is pointing to the left (user looking to the frontal of the 
module). In this position the CPU has default communication parameters: Device ID= 1, baud rate= 
9600 bps and even parity. 
 
Later these parameters may be changed using LogicView but they will only have effect when the 
communication key is on the non-default position. 

 

 

Physical Layer and Time out 
 
Now verify the communication settings to allow the LogicView to communicate with the DF65 CPU. 
Go to the menu Tools/Comm. Settings… and the following dialog box will open.   
Set interface for RS-232 physical layer as show in the figure. 
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PC communication parameters 
 
Next click on the “Time out” tab and set your time out and the number of times the computer should 
try in case of a bad communication. 
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The Time Out parameter is limited in 1000ms. That is, inferior values are rejected. In the example 
above if the user configure 200ms, this value will not be accepted by LogicView and an alert 
message will be shown to the user. 
 

 
 

Changing the CPU Communication Settings 
 
Consider that we have a serial RS-232 connection between the DF65 and the PC running the 
LogicView.  Make sure the serial cable is installed, the LogicView is set for RS-232 and the 
Communication Switch is in the default position. Now open the DF65 ONLINE dialog box using the 

menu: Tools/Online or click on . 
 
LogicView will try to connect with a DF65 CPU as soon as the online mode is called. If LogicView 
cannot detect the DF65 presence it will time out and wait with the DF65 ONLINE dialog box opened.  
This gives user a chance to modify some parameters to correctly set the communication.   
 
In case LogicView finds a CPU that matches the communication parameters it was already 
configured, it will add information on the Device, Version, Release, Configuration Name and present 
Status.  See dialog box bellow. 
 

 
 

The DF65 ONLINE dialog box 
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It is important to stress that the CPU module has 4 Dip Switches used to set the communication 
default parameters. In this case device address is 1 and baud rate is 9600 bps.  The easiest way to 
meet these conditions is to select the “Default” option under “Communication Parameter” on the 
figure above. In this condition we can not make changes in the Serial Port frame. 
 

Changing the DF65 Communication Parameters 
To change the DF65 communication parameter go and click on the “Comm Prm” button and work on 
the following dialog box. 
 

 
 

DF65 communication parameters setting 
 
After these parameters being changed the Send button will be enabled. The DF65 CPU will receive 
information and will inform that these modifications will only take place when user changes the 
communication DIP switch (see Chapter 4 Troubleshooting for more details about).   
 
There are 3 serial ports available in DF65.  A port P1 (EIA RS232) and two EIA RS485 ports (P2 
and P3).  User will be able to set each one of these ports: baud rate, parity and other specific 
parameters. 
 
Port P1 
Baud rate (9600 to 57600 bps) 
Parity (Odd or Even) 
 
RTS/CTS Timeout 
CTS: Signal that indicates device ready to transmission.  
RTS:  Signal to request data transmission 
 
The PC requests a connection with the CPU. The DF65 receives this request and process it.  After 
the DF65 sends the RTS signal and waits for the CTS signal for the time interval set on RTS/CTS 
Timeout. 
 
Off Duty  
Available time for communication when the CPU is not running a ladder diagram. The bigger is the 
value set for Off Duty, the bigger is the available time for communication. 
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Time Delay  
The PC sends a frame to the CPU, i.e., makes a communication request. The DF65 waits the 
amount of time set on Time Delay to process the frame request and send answer. 
 

Note: For better performance of your system we recommend: 
 
- OFF Duty must be se as 10 % of the Ladder cycle of execution. 
- Time Delay depends of the Workstation’s processor. If the processor is higher than a Pentium 
MMX 233 MHz we recommend that Time Delay is set for 5 ms. Otherwise we recommend that 
Time Delay is set with its default value.

 
Ports P2 and P3 
Port P3 is the port used for communication with remote I/Os (RIOs). Its baud rate is fixed in 56.7 
Kbps. Port P2 is the other serial EIA RS-485 channel and has two configurable parameters: baud 
rate (9600 to 115200 bps) and parity (odd or even). 
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TAGMONIT SOFTWARE APPLICATION 
BULLETIN 

Introduction 
 
The TagMonit is another software tool for monitoring Fieldbus Devices Variables. In order to use it 
proceed as follows: 
 

1 – Creating Tag list file 
 
The TagMonit software works from a text format file that contains the Tags of the parameters or 
variables to be monitored. The text file can be created with the Notepad software that comes with 
Windows operation system. You have to save this text file with the “LST” extension.  
 
Create you tag list file, as in the following example: 
 

 
 
The format of each list item is: <tagname>.<parameter>. 
 

2 – Starting Up TagMonit 
 
From the Start menu, select Programs\System302\Tag List Monit View\TagMonit.  
 
The following window will open: 
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3 – Connecting to the OPC server 
 
Click on the “New” button on the Tool bar to begin the TagMonit configuration, see next picture. 
 

 
When the following window appears, click on OPC Server button. 
 

 
 
Select the Local Server in the OPC Server Selection and choose the Smar OPC server from the 
registered list, then click on the OK button (See below). 
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4 – Adding the Tag List file 
 
Click on the button Tag List File.  
 

 
 
Select the file with “LST” extension that you have created in the item 1 and click on the button 
“Open”: 
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The following window will appear. 
 

 
 
Then, click “OK” on the above window and you will see the parameters being monitored, as in the 
next example. 
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TAGVIEW SOFTWARE APPLICATION 
BULLETIN 

Introduction 
 
The Tag View is a software tool for monitoring and actuation on Fieldbus Devices Variables. It is 
basically an OPC client of the OLE Server. The following section will guide you on the procedure to 
connect to the server, select monitoring variables and viewing them. 
 

1 – Starting Up TagView 
 
From the Start menu, select Programs/System302/System302 Application and select TagView. 
 
You can also activate it from the Start menu, selecting Program\System302\Tag List Monit 
View\TagView. 
 
The following application window will be prompted: 
 

 
 

2 – Adding the OPC Server 
 

 
 
To begin with, click on the button TagConf on the Tool bar (See below). 
 
When the following window appears, click on OPC Server field, as indicated. 
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Then, add the server to the list, by clicking on the respective adding button as indicated below: 
 

 
 
Select the Local Server in the OPC Server Selection and choose the Smar OPC server from the 
registered list, then click on the button OK (See below). 
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On the OPC Server Configuration window, click on the button Connect: 
 

 
 

3 – Choosing the Tag Monitoring Objects 
 
After the OPC Server is connected, the next step is to choose the objects to be monitored from the 
Tags in your configuration.  
 
Double click the Tag name and choose the parameter from the list. The user can select 20 items for 
each group and have 16 groups in a TagView project. 
 

 
 
Finally, click on the TagView button to start monitoring. 
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The following window will appear. 
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PROCEDURE FOR FIRMWARE 
DOWNLOADING TO DEVICES THROUGH 
FDI302 (FIELD DEVICES INTERFACE) 
 

Introduction 
 
The device firmware download is also made by FBTools software, same as PCI firmware, but it is 
done via computer serial port and not via ISA bus as in PCI. Because of that the device firmware 
download requires interfaces to be done. For the field devices, as LD302, TT302, FY302, an 
interface called FDI-302 (field download interface) is used. For FB700 module of LC700, the LC700 
configuration cable (C232-700) is used. 
 
This procedure stops the normal operation of the device. 
 
This kind of firmware download is helpful to keep the device with the most updated firmware 
revision, what guarantees always the most powerful and best devices. 
 

1 – Procedure for Firmware Downloading to Devices  

1.1 – Field Devices 
Step 1 – Connect the device to the computer 
 
Power the device with 24VDC (it is not necessary to be in a fieldbus line). 
Connect FDI-302 to the computer and to the device – this will freeze the device display. 
 

 
 
Step 2 – Run FBTools software 
 
From Start menu or from desktop area start the FBTools program. 
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Step 3 – Select the device firmware 
 
In the list of devices select the desired device and then click on the button Finish. 
 

 
 
When the Serial Download appears, click on the button Download if the correct firmware file path is 
showed. If you need to locate the firmware file, click on the button showed below. 
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Click on it to 
browse and locate

 
Step 4 – Download the firmware 
 
After clicking the button Download, the firmware transferring process starts. 
 

 
 
Then the software performs the downloaded firmware verification. 
 

 
 
The following screen will appear after finish the download. 
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Download Errors 
 
During the download process, some errors may occur. When any error happens, the download 
process should be restarted. See following the causes of these errors: 
 

 
 
Causes: the FDI interface may be not connected correctly or the device may be powered off.  
 

 
 
Causes: the communication may be lost during the firmware download or the download process was 
not well performed. 
 

 
 
Causes: the communication may be lost during the firmware download verification or the download 
process was not well performed. 
 

Note: If an error occurs during the download process the display can turn off. In this case restart 
the download procedure and complete the process. The equipment will restart to work properly. 

 
Step 5 – Restart the device 
 
The device must be powered off, disconnected from the FDI302 and then restarted again. 
 
For more information consult the FDI302 manual. 
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1.2 – FB700 
 
Step 1 – Connect the device to the computer 
 
Connect FB700 to the computer using the C232-700 that is the LC700 configuration cable.  
 
Now, look at the topside of the FB700 Module. You will see two push buttons through the ventilation 
openings. The one closer to the module front is used to enable the RS-232 port that is used for the 
firmware download.  
 
Push this button once and check if the 232 green LED is lighted. If it is, the module is ready to 
receive the firmware.  
 
 
Step 2 – Run FBTools software 
 
From Start menu open the FBTools program. 
 
Step 3 – Select the device firmware 
 
In the list of devices select the desired device and then click on the button Finish. 
 

 
 
When the Serial Download appears, click on the button Download if the correct firmware file path  is 
showed. If you need to locate the firmware file, click on the button showed below. 
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Click on it to 
browse and locate

 
Step 4 – Download the firmware 
 
After clicking the button Download, the process of transference and verification of the firmware will 
start. 
 

 
 
Download Errors 
 
During the download process, some errors may occur. When any error happens, the download 
process should be restarted. See following the causes of these errors: 
 

 
 
Causes: the C232-700 interface may be not connected correctly or the FB700 module may be 
powered off.  
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Causes: the communication may be lost during the firmware download or the download process was 
not well performed. 
 

 
 
Causes: the communication may be lost during the firmware download verification or the download 
process was not well performed. 
 
Step 5 – Restart the device 
 
FB700 module must have the serial port disabled. 
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PROCEDURE FOR MONITORING CRC 
ERRORS, THROUGH BRIDGE 
TRANSDUCER AND FBVIEW SOFTWARE 
 

Introduction 
 
Measuring the CRC (Cyclical Redundancy Check) errors is a good and efficient way to check and 
monitor the performance of the fieldbus line. Monitoring this value it is possible to know if the line is 
running properly and if the communication among the devices and the bridges is well done. An 
acceptable value for this measurement is equal or lower than 1%. 
 
The acquisition of this measure can be done in two ways: 
 
a) Via bridge transducer block: using the bridge already installed in the workstation and 

monitoring some parameters of its transducer block is possible to get the measure of 
the performance of the Fieldbus channels. 

 
b) Via FBView software: in this case is necessary another workstation running the tool 

software. The software collects the line signals and measures the efficiency of the 
fieldbus line. 

 
Using the FBView the user has the advantage of not to stop the supervision of the process in the 
workstation while monitoring the CRC errors measurement. 
 

1 – Procedure to monitor CRC Errors 
 

1.1 – Via Bridge Transducer Block 
 
The following steps must be followed when the communication between the process and the 
SYSCON configuration is running. 
 
Step 1 – Locate and open transducer block 
 
Open the Fieldbus channel window that the desired bridge belongs to. Right-click in the DFI 
transducer block and choose the option On Line Characterization. 
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Step 2 – Select the desired H1 Port 
 
In the open “on-line Characterization” windows find the parameter PORT_SELECT and set the 
number of the H1 port that you desire to monitor. The number of the chosen channel is shown in the 
parameter PORT_ID. 
 

 
 
Step 3 – Analyze the parameter values 
 
After the selection of the H1 port check the values of the following parameters: 
 
PORT_ST_PDU_SENT: This parameter presents the numbers of frames sent by the bridge to the 
fieldbus line. 
 
PORT_ST_PDU_RECEIVED: This parameter presents the number of frames received by the bridge 
from the fieldbus line. 
 
PORT_ST_WRONG_FCS: This parameter presents the number of wrong frames among the 
received ones. 
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1.2 – Via FBView Software 
 
FBView is easy to use and runs on Windows platform. FBView needs an interface that captures the 
messages from the bus and sends it to the computer. The interface available is the DFI with an 
FBView firmware . DFI with FBView firmware is connected in parallel in the bus as a common 
device.  
 

 
 
Step 1 – New File 
 

After start the FBView software select the New File Button.  A new popup window will appear. 
Select the communication network used to collect the data from the Fieldbus line to FBView 
software. Click OK. 
 

 
 
A new FBView Window will open. 
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Click on the Online Icon.   Choose Interface Window will pop up. Select Ethernet. Click OK. 
 

 
 

Click on the Interface Icon.   
 
FBView will detect the DFIs connected in the network. In the field Interface ,select the DFI that has 
the special firmware to FBTools. Click OK. 
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Step 2 – Capturing Frames 
 

Click on Capture button to start capturing frames.  Frame Statistic will run 
 

 
 

Click on “Stop” button.  
 
Step 3 – Frame Statistics 
 
After capturing, the following window will appear to show the errors. 
 
For additional information consult the FBView  manual. 
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DFI DIVER / PCI DIVER QUICK 
REFERENCE 
 

Introduction 
 
Diagnosis of DFI/PCI is an advanced and very powerful feature of System302. DFI/PCI is the main 
LAS (Link Active Scheduler) in the system and is the interface between the control that is performed 
in the field and the supervisory software that runs on the workstations, in which the DFI/PCI cards 
are installed. 
 
The DFI Diver/PCI Diver software allows the user to get some data stored in the DFI/PCI cards that 
can be very useful. Information such as the firmware version that is running on the hardware, how 
much time the DFI/PCI is running without resets, how much memory is still available for use and so 
on. 
 
This software is part of System302 package and is found in the same folder than FBTools. 
 

1 – DFI Diver/PCI Diver – Settings Screen 
 

 
 
This screen is divided in two sections: DFI/PCI settings and DFI Diver/PCI Diver settings. 
 
In the DFI/PCI settings section, it is chosen the DFI/PCI  that will be analyzed and it is also 
presented the main settings of the card, such as firmware version and date, the size of the firmware 
program and the revision of the firmware. 
 
Still in this section, the user sets time intervals, in milliseconds, in which the task update will be 
executed. Here, the user sets the interval between the readings of performance values, messages 
and watches the commands on the fieldbus line and on DFI/PCI RAM.  
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2 – DFI Diver/PCI Diver – Performance Screen 
 

 
 
In this screen, it is presented the following performance values: 
 
RTK time: the time of operation of RTK (real time kernel) – the operational system of the DFI/PCI – 
without any restart. 
 
CPU time: the time of operation of the DFI/PCI CPU without any RESTART. 
 
Benchmark:  the time of operation of a subroutine by the processor. 
 
CPU Usage: percentage of the CPU memory used to execute the tasks. 
  
Restarts: numbers of restarts that DFI/PCI passed under. If this number is high can be a signal of 
problems in DFI/PCI and/or line. 
 
Fault: counter of faulty commands and operations in DFI/PCI CPU. 
 
RTK major: counter of faulty commands and operations detected by RTK. 
 
In the bottom of the screen is presented a table with information about the tasks that the DFI/PCI is 
running. 
 
Task Name: the name of each current task. 
 
Priority: the importance of each task assigned by RTK. Lower value is more important.  
 
Status: status of the task. “Ready” status means that the task is currently running and “Waiting for 
Timer” means that the task is waiting for a timing command to be run. 
 
Scheduled: is the counter of how many times the task was run. 
 
Stack Status: indicates the status of the stack dedicated to the task. 
 
Stack Beginning: indicates the beginning address in memory of the stack dedicated to the task. 
 
Stack End: indicates the end address in memory of the stack dedicated to the task. 
Stack Size: indicates the size in memory of the stack dedicated to the task. 
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Stack Never Used: indicates how much of the memory was never used for the task. 
 
Stack not in use: indicates how much of the already used memory is not being used. 
 

 
 

3 – DFI Diver/PCI Diver – Message Screen 
 

 
 
This screen is used for debug information. This screen is used for routine messages readings to 
help on debug tasks. 

4 –DFI Diver/PCI Diver – RAM Information Screen 
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On this screen it is found information about the RAM memory of DFI/PCI card and of its subdivisions 
as Heap part (responsible for dynamic allocation), Supervision Stack (stack for main processor 
supervision) and Interruption Stack (stack for interruption for main processor). 
 
In the cluster analysis part of the screen, the user can obtain an analysis of determined clusters of 
the memory. The user who sets the size and the pattern to be searched in the memory in the 
Cluster Size and Pattern fields determines those clusters. 
 

5 – DFI Diver/PCI Diver - Watch Screen 
 

 
 

On this screen, the user reads the values in memory directly. The user is able to read what is written 
in memory dynamically.  
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To do that, it is necessary to know the memory position of the desired value and its variable type. 
This information must be entered and the value can be monitored in the watch screen, as in the 
example. 
 

6 – DFI Diver/PCI Diver - Trace Back Screen 
 

 
 
This screen displays the last actions of the processor until an error occurs. These information are in 
low-level language. Pressing the Save button you can save these information in a file. This file can 
be sent to Smar to analysis. 
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TAGLIST SOFTWARE APPLICATION 
BULLETIN 
 

Introduction 
 
The software Tag List Generator for the DF65 OPC Server is developed to generate an information 
Table to the DF65 OPC Server telling which are the Tags for each Modbus Address. 
 
The advantage to configure using links to Tags is that if the user changes the DF65 configuration 
the Modbus address will change, but the Tags will not. The OPC Server will be able to read the new 
Tag List generated after the changes made with the LogicView. 
 

1 – Starting Up TagList DF65 
 
From the Start menu, select Programs/System302/System302 Application and choose TagList. 
 
You can also activate it from the Start menu, selecting Program\System302\Tag List Monit 
View\TagList. 
 
The following window will open. 
 

 
 

2 – Creating a New Project 

To create a New Project, click on the File menu, then click New, or click on New button, ,on the 
toolbar. 
 

3 – Adding Ports 
 
Right-click on the Connections Icon and Add a connection. 
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The Add Connection window will open. Fulfill the fields and click OK. 
 

 
 

4 – Adding a Configuration 
 
Right-click on the Device List icon, choose Add.  
 

 
The TagList will open a window. Select the DF65 configuration file which contains the desired 
configuration. 
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The Add Device window will open. Select the Main Connection Port and provide the DF65 correct 
Device ID. 
 

 
 
After add the ports and devices, the configuration will seem like the following window. 
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5 –Registering the Project 
 
In order to compile the project (to generate the Tag List) it is necessary to first save the current 

project. Click on the Save icon, , on the toolbar.  
 

 
 
To register a project, just click on the OPC menu, then click on Register Tag List, or click on 

Register Configuration. Button, , on the Toolbar. The following window will appear.  
 

 
 
Click on the Tag List folder and check the Tag List Table generated for the current configuration. 
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6 – Using MCT ( Modbus Cross Table ) 
 
In this option, the user can choose which points will be monitored by the device that uses the 
Modbus protocol. The goal is create a Modbus sequential table in the CPU in order to get a better 
HMI register monitoring performance. 
 

NOTE: TagList V8.54 allows a Modbus Cross Table configuration valid for E3 CPU, only. 
 
Step 1 - Configuring MCT 
 
In this option, the user can choose which points will be monitored by the device that uses the 
Modbus protocol. 
 
To configure the MCT table, select the address range required on the Working folder. The address 
Table will appear at left.  
 
Four Address Ranges will become available to visualize the configuration points: 
 
0x: Digital Outputs and Virtual Points. 
1x: Digital Inputs. 
3x: Analog Inputs. 
4x: Analog Outputs, Function Blocks and  Special Registers. 
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In order to configure the MCT table, click on the Add Cell button.  One line will be added in the 
table. 
 

 
 
Click with the left button on the Tag in Modbus Table and drag it to the added cell in MCT Table. 
 

 
 
Repeat the step above to add all points which must to be monitored. 
 
Step 2 - Download to Device 
 
To configure the MCT Table, it is necessary to do the download of the added points.  
 
Right-click on each one of the address ranges in the Working folder. A popup menu will be opened, 
select the Download to Device option or click on Edit menu and choose the Download to Device 
option. See the following picture: 
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After doing the download of all points the following message will be shown. 
 

 
 
Step 3 - Upload from Device 
 
After all points of the MCT Table had been sent to device, the upload of these points must be done 
in order to compare them.  
 
Right-click on the Address ranges in the Device folder, a popup menu will be opened. Choose 
Upload from Device or click on the Edit menu and select the Upload from Device option. 
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After doing the upload of all points the following message will be shown. 
 

 
 
Step 4 - Comparing the Tag Tables 
 
It is possible to do the comparison of the Working and Device Tables.  
 
Click with the right button on one of the address ranges in the Working or Device folder. A popup 
menu will appear, choose the Compare MCT Tables option, or click on Edit menu and select 
Compare MCT option. 
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We can observe the status of the points in the Compare MCT Tables:0 
- OK: the Device and Working original addresses are the same. 
- Tag Mismatch: the Device and Working original addresses are different. 
- Not found in Device: the original address was in Working was not found in Device. 
 
The Replace button replaces the Device Table points to Working Table. 
The Close button closes the window. 
 

7 – Using Conversions 
 
For each Tag, the user can choose if this Tag Value will have conversion from device scale (Device 
Range) to client scale (Engineering Units), or not.   
 
Click with the right button on Conversion folder, a popup menu will be opened, choose Add option. 
The following window will appear. 
 

 
 
After having created a Conversion Rule, the user needs to assign this Conversion to a Tag. 
 
Select the Tag List folder. Click on the Conversion field, a popup menu will open to assign the 
Conversion to the Tag.  
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NOTE: 
• Only Tags that can be represented in Eng. Units (EU) can be converted. 
Tags with DATA TYPES: WORD, DWORD, INT and REAL are allowed to have conversion.  
•Tags with DATA TYPES: BOOL, and BYTE are Tags that has no conversion to EU. 

 

8 – OPC Monitor 
 
The TagList has a tool that can monitor points using the DF65 OPC Server. 

Click on Edit menu, select Compare MCT option or click in the OPC Monitor button, . 
 
A dialog box will appear. Choose the DF65 Server and click on the Connect button. 
 

 
 
The OPC Monitor screen will open. Double-click to add/delete variables 
 



TagList Software Application Bulletin  
 

AH.11 

 
 
To start monitoring, click on Start Monitoring button. To end monitoring, click on Stop Monitoring 
button. 
 

 
 
For additional information consult the TagList Generator manual. 
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SYSCON SECURITY MANAGER 
 

Introduction 
 
Security Manager is a tool in Syscon 6.0 that avoids unauthorized users to open the configuration 
file. This appendix will show how do use and configure this. 
 

1 – Opening Security Manager for the First Time 
In the Syscon window, open the Project File menu and choose Security. 
 

 
 
The Security window will open. 
 

Note: Only the Administrator can change and configure the users Database. When you use the 
security manager for the first time the default administrator user will be Administrator and the 
password will be Unit XVI.  

 
Type the User Name, Password and click the Login button. 
 

 
 
Now the user is logged in. 
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2 – Enabling Security  
 
Only the administrator can activate and deactivate the Security Manager.  
 
After Login, select the option Activate. When the Security Manager is activated, it will be necessary 
that the user logs to Syscon before opening the application. 
 

 
 
To deactivate the Security Manager, clear the option Activate. Now, any user can run the Syscon 
and open the configuration file. 
 

 
 

3 – User Management 
 
To manage the users in the database, click the Change Button.  
 

 
 
The dialog box will expand. 
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3.1 – Creating Users 
 
Adding Users 
 
Only an administrator user can add new users to the user list. 

 
1. Type the User Name of the new user 

 
2. Type the full name of the user in the Name field. 

 
3. Type the description of the user in the Descr. field.  

 
4. Type the user password in the New and Repeat fields. 

 
5. Click Add to include the new user 

 

 
 
Changing Profile 
 
The Profile option determines the type of access for the user. 
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The Adm profile allows the user to create, update and remove users from database. It is not 
possible to change the information about the Administrator. 
 
The Mng profile allows the user to modify password and verify information about other users. 
 
The Usr profile allows the user just to log and run the Syscon application. These kinds of user do not 
have access to the information about other users, as a result the Change button will be disabled. 
 

3.2 – Updating Attributes for the User 
 
Changing Passwords 
 
To change the password, the user has to be logged.  
 

Note: This procedure is done just to change the user own password. In case of a user with 
Administrator profile wants to change the password of other user, see the next topic “Changing 
Users Information”.  

 
See in the example below,  the user Guest will change his own password. 
 
Type the new password in the New and Repeat fields. 
 

 
 
Click Confirm.  A message box will appear to confirm the operation. Click Yes to apply changes or 
No to cancel the operation. 
 

 
 
Changing Users Information 
 
To update the user information, select the name of the user from the User List. The password, 
profile, name, description and also the user name can change. 
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Enter the new information about the user and click the button Update to save the values. 
 
See example below, the Administrator user will change the password of the Guest user 
 

 
 

3.3 – Enabling Users 
 
The option Enable is used for enable/disable the user account. When the user account is disabled, 
the account still exists but the user will not have the access of Syscon application. 
 
To enable/disable a user, you have to activate/deactivate the Enabled check box. 
 

 
 

3.4 – Removing Users 
 
Only a user with administrator profile can remove users from the Security Manager. 
 
To remove a user, select the user name in the User List and click the button Remove. 
 

 
 
A message box will appear to confirm the operation. Click Yes to finish or No to cancel the 
operation. 
 

 
 

4 – User Logout 
 
To logout from the Security Manager, go to Project File menu and select the option Security. The 
following window will appear. 
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Click the Logout button. A message box will open to confirm the operation. 
 

 
 
 

 



Appendix J 
 

AJ.1 

MODBUS COMMUNICATION IN SMAR 
SYSTEM 302 
 

Introduction 
 
This section will show the necessary configurations to implement Modbus in Smar System 302. 
 
For this section, the knowledge on how to use the Syscon and Logic View software is considered 
pre-requisites to understand this informative. In case of doubts please consult the Function Block, 
Syscon, Logic View and DF65 manuals for reference. 
 

1 – Architecture 
 
The architectures used can be the Modbus Serial Communication Mode or the Modbus TCP/IP 
Communication Mode. As follows: 
 

 
Mode 1: Modbus Serial Communication 

 
Mode 2: Modbus TCP/IP 
Communication  

 
Both architectures use the serial communication but in mode 1, the communication between the 
foundation fieldbus processor and the PLC is made through a serial cable that connects the two 
CPUs. In mode 2, it is used a modbus gateway (MB700) to make the communication between the 
two CPUs. 
 

2 – Modbus Blocks 
 
DFI302 has function blocks that allow  the Modbus communication, it means that using these blocks 
the Fieldbus equipment is able to exchange data with the Modbus equipment. These blocks are: 
• MBCF - ModBus Configuration; 
• MBCS - ModBus Control Slave; 
• MBSS - ModBus Supervision Slave; 
• MBCM - ModBus Control Master; 
• MBSM - ModBus Supervision Master. 
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This appendix will present a guideline with the minimum configuration necessary to make a modbus 
communication. Detailed information about modbus blocks and its parameters can be find in the 
Function Blocks Manual, section Modbus Function Blocks. 
 

3 – Configuration 
 
In this topic will be described the necessary configuration for the integration between DFI302 and 
DF65.  In this case we are considering the DFI302 as a Modbus Master to DF65. The system 
architecture can be represented through the figures above. See the following steps: 
 

3.1 – Mode 1: Modbus Serial Communication 
 
Step 1 – Implementing the Strategy 
 
Using the Simple  PID configuration done in the chapter 1, it will be implemented an analog alarm in 
the temperature transmitter. The alarm signal will be sent to the read/write modbus block 
ModContMaster. 
 
See the control strategy in the picture below: 
 

 
 
The user has to insert the additional function blocks MBCF (ModConfig), MBCM (ModContMaster), 
MBSM (ModSupMaster), Analog Alarm (TT-123_AALM) as shown in the picture below: 
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The alarm signal from TT302 will be sent to  DF65 logic configuration and it will be represented by 
the NA virtual relay IN_D1.  
 

 
 
Moreover, it will be monitored the DF65 signals through the Foundation Fieldbus blocks in DFI302.  
 
Step 2 - ModBus Configuration 
 
The MBCF block is used to configure several communication parameters of the modbus protocol. It 
allows setting the communication parameter between DFI302 and a modbus slave/master device. In 
this example the DF65 is  slave and DFI302 is master.  
 
The user can configure the communication media (Serial or TCP/IP), device address, rate of 
transference, parity, timeout and number of retransmissions. 
 
In the figure bellow, see the parameters that have to be configured to the Modbus Serial 
Communication Mode.  
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Step 3 - ModBus Control Master 
 
The MBCM block is used in strategies that the DFI and the modbus device have to exchange 
information. In this case the DFI will be able to read and write modbus variables, exchange data and 
interact with the FOUNDATION Fieldbus control strategy.  
 
See in the control strategy above that the Modbus Control Block (ModContMaster) is being used to 
write data in the PLC. It is represented for the link OUT_ALM → IN_D1, which alarm output of 
TT302 is sent to a modbus writing parameter.  
 
In the example bellow see the parameters that have to be configured in MBCM. 
 

 
 
Every MBCM block added to the configuration must have different values of LOCAL_MOD_MAP 
parameter. 
 
This block has four digital inputs and outputs and four analog inputs and outputs. See in the table 
below the description of how is made the communication of the inputs and outputs for each block. 
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Parameter Description 
IN_Dn The Fieldbus discrete signal connected to this port will be written in the 

Modbus address specified by the parameter LOCATOR_IN_Dn.  
OUT_Dn The Fieldbus signal connected to this port will read the Modbus 

discrete signal from the modbus address specified by the parameter 
LOCATOR_OUT_Dn. 

INn The Fieldbus analog signal connected to this port will be written in the 
Modbus address specified by the parameter SCALE_LOC_INn. 

OUTn The Fieldbus signal connected to this port will read the Modbus analog 
signal from the modbus address specified by the parameter 
LOCATOR_OUT_Dn. 

 
As example let’s configure a digital input that will be sent to a virtual variable in the DF65 logic 
configuration. In the figure below the LOCATOR_IN_D1 configures the address of the digital input 1 
in slave device. 
 

 
 
The SLAVE_ADRESS has the address of the slave modbus device that is the DF65 module, with 
address 1. 
 
The MODBUS_ADRESS_OF_VALUE has the modbus address of the discrete variable. This value 
can be found in the LogicView Modbus Address Table. As follows. 
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The same steps must be done to configure analog input/output and digital output. 
 
Step 4 - ModBus Supervision Master 
 
The MBSM block enables the DFI302 to monitor Modbus variables.  
 
See in the control strategy that the Modbus Supervision Block (ModSupMaster) is used only for data 
supervision from modbus, so that it is not possible to do links with this block. 
 
In the example below see the parameters that have to be configured in MBSM. 
 

 
 
Every MBSM block added to the configuration must have different values of LOCAL_MOD_MAP 
parameter. 
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The user can configure different parameters to monitor float (FVALUE), percentage (PVALUE), 
integer (IVALUE) and boolean (BVALUE) variables from modbus device. 
 
The same way as in the MBCM, each one of this parameters have to be associated to a modbus 
device address.  See the example below that configures a boolean variable in the BLOCATOR 
parameter.  
 

 
 
In this example will be supervised the signals SW1, In_D1 and OUT 1 from DF65 logic 
configuration. 
 
The parameter SLAVE_ADRESS has the address of the slave modbus device that is the DF65 
module. The parameter MODBUS_ADRESS_OF_VALUE has the modbus address of the discrete 
variable. This value can be found in the LogicView Modbus Address Table. As follows. 
 
The same step has to be followed to configure float (FLOCATOR), percentage (PLOCATOR) and 
integer (ILOCATOR) variables. 
 
Step 5 – Analog Alarm 
 
Configure the Analog Alarm block from TT302 as following: 
 

 
 
With this configuration every time that the temperature measured by TT302 is lower than 10, the 
block will generate an alarm, that can be noticed by the discrete state “1” in the parameter 
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OUT_ALARM. 
 

3.2 – Mode 2: Modbus TCP/IP Communication 
 
Step 1 – Implementing the Strategy 
 
See Appendix J, item 3.1, step 1. 
 
Step 2 – Modbus Configuration 
 
See an example of Modbus TCP/IP Communication Mode. 
 

 
 
Step 3 – Modbus Control Master  
 
See Appendix J, item 3.1, step 3. 
 
Step 4 – Modbus Supervision Master  
 
See Appendix J, item 3.1, step 4. 
 
Step 5 – Analog Alarm 
 
See Appendix J, item 3.1, step 5. 
 
Step 6 – Configuring MB700 
 
 

Note:  If the user uses the default communication parameters to DF65 and MB700, it is not 
necessary to execute this step. See below the default communication parameters: 
             - BAUD_RATE = 9600 bps 
             - STOP_BITS=1 
             - PARITY=EVEN 
             - TIME_OUT= 1000 

 
To change some communication parameters the user has to follow the instruction below. 
 
Create a MB700 in the configuration according the following pictures: 
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Parameterize the blocks according table below: 
 

Tag Block Type Parameter 
MB700_RES Resource MODE_BLK.TARGET=AUTO
MB700_TRD Transducer MODE_BLK.TARGET=AUTO
ConcConfig Concentrate Configuration MODE_BLK.TARGET=AUTO

BAUD_RATE=9600 
PARITY=Odd 
TIMEOUT=2000 

 

Note: Every time that the user modifies the CCCF block from MB700, it is necessary to set the 
ON_APPLY parameter to Apply, otherwise the alterations will not be effective. This adjustment 
must be done with the block in  Online Mode. 

 
In this example we use a baud rate of 9600bps, odd parity and timeout of 2000 ms.  
 
For more information please consult the MB700 manual, CCCF Function Block. 
 

4 – Init Communication 
 
Its necessary to init communication, attribute devices IDs, check the Live List, assign tags, 
download the configuration and export tags, as shown in the sections 1.6 to 1.10 from this manual.  
 

Note: Every time that the user modifies a Modbus parameter, it is necessary to set the ON_APPLY 
parameter of de MBCF block to Apply, otherwise the alterations will not be effective. The same 
procedure must be done in the ON_APPLY parameter from MB700 CCCF block. The parameter 
ON_APPLY must be adjusted in the online configuration, but never must be saved in the offline 
configuration. 

 
Right-click in the ModConfig block and choose the On Line Characterization. 
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In the parameter ON_APPLY change the status to Apply. 
 

 
 
Do the same procedure described above in the ConcConfig block. When close the window above. 
the change made in the parameter ON_APPLY must not be saved. 
 
With these basic steps the user will able to do a configuration that allows the communication 
between FOUNDATION Fieldbus and Modbus equipments using the Smar System 302. 
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